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- .FUNC

About Netlist Translator for SPICE and Spectre

Spectre is an EDA (Electronic Design Automation) tool produced by Cadence Design Systems, Inc. The Simulation
Program with Integrated Circuit Emphasis (SPICE) was developed at University of California Berkeley and has been
commercialized and modified by a large humber of vendors. It has also been adopted and modified by electronics
companies for their own in-house use. Spectre and SPICE are used by engineers throughout the world for simulating
circuits of all types. Many designers and companies have large investments in existing subcircuits or device models
described by Spectre and SPICE netlists that they want to use with the Advanced Design System (ADS) from Agilent
Technologies.

Advanced Desigh System

Advanced Design System has been developed specifically to simulate the entire communications signal path. This
unique solution integrates the widest variety of proven RF, DSP, and electromagnetic design tools into a single,
flexible environment. Building on years of expertise developing new technologies for our EDA tools, such as Series IV
and MDS, Advanced Design System provides a broad range of high-performance capability. This makes it easy to
explore design ideas and model the electrical and physical design of the best candidates.

Netlist Translator

Providing the ability to simulate a Spectre or SPICE netlist in ADS is a fundamental purpose of the Netlist Translator.
The Netlist Translator is an ADS tool that enables you to import netlists into schematics and/or netlists for use with
the ADS simulator.

Since Spectre, SPICE, and ADS simulators use different simulator technology, there may be incompatibilities between
your original file and the resultant ADS file that the translator is unable to resolve. The incompatibilities may show up
as import errors, simulation errors or differences in simulation results.

Every attempt has been made to record these inconsistencies in the translator log file, nettrans.log. Detailed
information in this manual will help you identify and understand these limitations.

Major Benefits
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The Netlist Translator enables you to perform the following:
e Generate an ADS schematic from a Spectre or SPICE Netlist for use in circuit design and simulation.
¢ Generate an ADS netlist from a Spectre or SPICE Netlist for use in simulations.

e Translate model files to incorporate them into ADS Design Kits.

Major Features

Key features of the Netlist Translator include the following:

e Automatic ADS design generation that includes circuit schematic, required model definitions and circuit equations
or a reference to an equivalent ADS netlist to be used directly in simulation.

e Translation of component and model parameters to equivalent ADS parameters. In some cases this requires
additional equations if the parameters do not translate directly. Parameters that cannot be translated are listed
in the translator log file, nettrans.log.

Supported SPICE and Spectre Dialects

The Netlist Translator supports several SPICE dialects that are widespread throughout the electronics industry. The
following table lists the five main dialects supported by the translator.

Supported SPICE and Spectre Dialects

Name Manufacturer Version
Spice2 UC Berkeley 2G6 (1981)
Spice3 UC Berkeley 3F3 (1993)
PSpice Cadence 9.9.2 (August 2001)
HSpice Avanti/Meta Software v2003.3 (March 2001)
Spectre Cadence IC 5.1.41, Open Access 5.1.41, and

Open Access 5.2.51

 Note

For translation purposes, Spice2 and Spice3 are almost identical and are referenced in this manual as
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Spice2/3.

General Process

The main objective of using the Netlist Translator is to import your Spectre or SPICE netlist into ADS. This enables you
to simulate your design using the powerful tools provided by ADS. The following figure shows a simplified task flow for

using the Netlist Translator.

Spectre or SPICE Metlizt File

_/

'

Tranzlate the Metlizt into
ADS and compare netlistz

/

@d Simulation Control Elements

2/

Y
(E-imu late the ADS Schematic

N

Y

Compare vour ADS =imulation resultz
with vour origional resultz

Simplified Task Flow

What's in this Manual

The goal of this manual is to help you get started, provide relevant examples that teach you how to use the software,
assist you in analyzing your translation and show you where you can get more information as you need it.

e Importing a Netlist File provides detailed instructions on using the Netlist Translator's user interface to import a
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netlist file into an ADS schematic or to an ADS netlist. Several example Spectre and SPICE netlists are used to
help you understand and practice using the translator.

e Advanced Methods for Importing Files provides detailed instructions for advanced users who want to understand
how to use the command line options that are available within the Netlist Translator. Additional information is
provided to help with customizing components and other unique situations.

e Simulating the Translated Netlist provides general information on setting up, performing and analyzing a
simulation using Advanced Design System. References to more detailed information are also provided in this
chapter.

e Comparing Results provides information on comparing the output of your translation to your original netlist file.
This chapter points out some specific details to look for when comparing your results.

e Troubleshooting provides helpful information on debugging imported designs and includes information on error
and warning messages. Some known problems are described and solutions are included where available.

e Translating a Device provides detailed device translation information for individual components.
e Translating a Model provides detailed model translation information for individual models.

e User Defined Models and Parameter Mapping Rules provides information on adding your own unique models to
ADS.

e Translating Commands and Functions provides information on the various commands and functions supported by
the Netlist Translator.

About Design Translation and Verification

Design translation can be a very complicated process. It is important to understand that it is rarely, if ever, a
push-button utility. Before starting a translation, you should become familiar with all parts of your design and be
prepared to spend adequate time to ensure that all parts are translated correctly. After the initial translation is
complete, additional work may be required to understand model differences. Verification and debugging the translated
design may involve breaking a complex design down into smaller pieces to test simulation of small circuits before
attempting to simulate a large design.

The support staff at Agilent Technologies can assist you in this process, but should not be expected to perform a
complete translation and simulation. Please plan your project accordingly, allowing sufficient time in your schedule to
use this tool as it is intended — as a tool to assist in the transfer of design information from one system to another.

Importing a Netlist File
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This chapter describes the procedures for importing Spectre or SPICE netlist files into ADS using the Netlist
Translator's User Interface. Performing a translation via the User Interface enables you to easily define the translation
criteria and translate your netlist file. You have the option of generating either an ADS Schematic or an ADS Netlist
plus an ADS Schematic with a NetlistInclude component depending on your selections.

If you have a relatively simple netlist file and only need a schematic, the ADS Schematic option is recommended.
However, if you have a large or complex netlist source file or you are just more comfortable viewing a netlist version,
the ADS Netlist plus an ADS Schematic with a NetlistInclude component option enables you to review the netlist. This
makes it easy to compare your files line by line for debugging purposes. The netlist version also provides much faster
processing.

Importing a Netlist File Using the User Interface

Importing a netlist file to an ADS Schematic or an ADS Netlist with a NetlistInclude component using the Netlist
Translator can be broken down into several simple steps.

Accessing the Import Dialog

Specifying the File Name

Setting the Import Options

Choosing the Translated Output Format
Defining Netlist Options *

Examining the Output

Using the NetlistInclude Component *

NouhWN=

 Note

Steps 5 and 7 above are only necessary if you want to import to an ADS Netlist with a NetlistInclude
component.

Creating a Simple Spectre Example

The following simple RCL-Diode circuit will be will be referred to periodically in the documentation to help with your
understanding of the import process. If you like, you can create the sample Spectre file shown in Sample Spectre File

(ex1.scs). You can create this file in your project directory using any ASCII text editor. Type the following text into a
file.

Sample Spectre File (ex1.scs)

*R, C, L & Diode Example

L1 (netl net2) inductor |=1n

R1 (net2 net3) resistor r=1K

C1 (net3 net4) capacitor c=1p

D1 (net4 net5) pdiode |=3e-4 w=2.5e-4 area=1
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model pdiode diode is=1.8e-5rs=1.43 n=1.22

Save this file as ex1.scs in your current project directory then close the file. You can now use exl.scs as an example
the first time you attempt to perform an import operation.

Creating a Simple SPICE Example

Create the sample SPICE file shown in Sample SPICE File (ex1.sp). You can create this file in your project directory
using any ASCII text editor. This, and other simple SPICE files, will be referred to periodically in the documentation to
help with your understanding of the import process. Type the following text into a file.

Sample SPICE File (ex1.sp)

*SIMPLE RTL INVERTER

VCC405

VIN 1 0 PULSE 0 50 2NS 2NS 2NS 30NS

RB 12 10K

Q1 32 0 MODQ1

RC 34 1K

.MODEL MODQ1 NPN BF=20 RB=100 TF=.1NS CIC=2PF
.DCVINO050.1

.TRAN 1NS 100NS

.END

Save this file as ex1.sp in your current project directory then close the file. You can now use exl.sp as an example the
first time you attempt to perform an import operation.

Accessing the Import Dialog

You can import files through Advanced Design System's Main or Schematic window. The Import dialog box is accessed
from the File pull-down menu.

Open a project in ADS before importing your design. Working in project directories enables the translator to organize
design files in the standard ADS file structure.

Choose File > New Project to open a new project or File > Open Project to open an existing project.

 Note

The import option will not be active in the File menu unless you open a project.

For more information on working in project directories, refer to " Managing Projects and Designs " in the Advanced
Design System Schematic Capture and Layout manual.
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Before invoking the import procedure, close any open designs. This will remove any active designs from memory.
Choose File > Close All
To access the import dialog and import your design from the ADS Main or Schematic window:

Choose File > Import. The Import dialog box appears.

—| import

File Type

IFF ‘| HMore Options...
Import File Hame {Source)
Browse...

Dataulis Dosign

Hewr Deshis: Mane {Destilntian

B, .

_ OK Cancel Help

Specifying the File Name

In the Import dialog box, choose the type of file to import, specify the filename and supply other basic information
needed by the translator.

1. In the Import dialog box, select Netlist File from the File Type drop-down list if it isn't already displayed.
2. To specify the path and filename of the file you want to import, click Browse in the Import dialog box. The _
Import File Selection_ dialog box appears.

12
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=| Import File Selection |

Filter
wnplesfads_priprojectsfexample 1 _pHr{

Directories Files

rojectsfexample 1 prjf. exl.scs
wojectsfexample 1_prif.. ——— Select your exl.sp
example file

selection

sfads_prjfprojectsfexample_1_prjfexl sp:

OK Filter Cancel Help

3. Double-click as needed to locate the directory containing your source file in the Directories field, then click the
file in the Files field. Alternatively, you can enter the full path and file name in the Selection field.

4. After selecting the design you want to import, ex1.sp for this example, click OK. You are returned to the Import
dialog box and the selected filename appears in the field labeled Import File Name (Source).

5. Click More Options to define the preferred import method. The Import Netlist Options dialog box appears.

Setting the Import Options

Selecting the Dialect

In the Import Netlist Options dialog box, select the appropriate netlist dialect from the Input Netlist Dialect drop-down
list.
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=| Import Netlist Options

Input Hetlist Dialect

PSPICE :

® First line is a comment

_| Suppress name mapping

— Translated Output Fornmat

@ ADS Schematic {with named connections)

_) ADS Netlist

— Qptonal Directory Location

Divr:bary To Store ADS Hedlis
{tlaraits o project directory )

| I Browse...

Element Replacement Table

| ]

k-l T}

If you are unsure of the source of the netlist file, you may be able to tell from the syntax of in line comments shown in
Recognizing Netlist Variations.

Recognizing Netlist Variations

SPICE Dialect In line comment syntax
Spice 2G In line comments not allowed
Spice 3 In line comments not allowed
PSpice H
HSpice $
Spectre /!
 Note
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For HSpice, the " $' must be preceded by a space or a comma if it is not the first non-blank character because
the $ is allowed within node or element names.

You may also be able to match syntax with the device table or model levels in the model tables. For more information
on device and model tables, refer to Translating a Device and Translating a Model.

First line is a comment:

To make sure the first line of a source file is recognized as a comment line and ignored, the First line is a comment
checkbox must be selected. This is not necessary if the line already begins with a comment character.

=| Import Netlist Options |

Input Hetlist Dialect

FPSPICE

® First line is a comment
| SUppress name mapping

Translated Output Format

# ADS Schematic (with named connections)

1 ADS MNetlist

Chifinnnd Direciory Lotalion

Dieciory o Stpe ADDS Hetlst
fodofadie fo prndeol diealory

{ Errrarse,.,

Element Replacement Tahle

w

Ok Cancel Help

The First line is a comment option is available because some simulators will always ignore the first line regardless of

the first character.
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Use the default value for the ex1.sp example.

Suppress name mapping:

When the translator changes the name of a node or a component to comply with ADS rules, this is referred to as
name mapping. Name mapping is limited to all names being changed to lowercase, as well as replacement of an illegal
character with an underscore. For more information on name mapping, refer to Using Valid ADS Characters.

Click the Suppress name mapping check box to activate or deactivate this option. Activating this option enables you to
override any name mapping introduced by the translator.

 Note

See Understanding Capitalization for cautionary information on nhame mapping.

Use the default value for the ex1.sp example.

Choosing the Translated Output Format

In the Import Netlist Options dialog box, there are 2 import methods available in the Translated Output Format field:
ADS Schematic (with named connections) or ADS Netlist . See Translated Output Format Descriptions for format
descriptions.

 Note

A third option, Wires , is available through the command line only. See Translated Output Format Descriptions
for more information.
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—| import Netlist Options

Input HMetlist Dialect

PSPICE f

X First line is a comment

| Suppress name mapping

Translated OQutput Format
# ADS Schematic {with named connections)

1 ADS Hetlist

Chitiniad Direcipry Localien

Direclary Ta Slore ADS Reihst
foeiagls o prpipcl demctaryd

Famse,,,

Element Replacement Tahle

s

OK Cance] Help

Translated Output Format Descriptions

e ADS Schematic (with named connections) This translation method writes an intermediate file in the Intermediate
File Format (see Importing an IFF File). After the IFF file is created, it is read by ADS and the schematic is

created. For detailed information on how this works, refer to Understanding the Import Operation. Components
are placed in a square array and Named Connections are used to place the correct hode name on each pin. Pins
with the same node name are connected. This translation is faster than the Wires option that tries to connect all

the pins with wires.

e ADS Netlist An ADS netlist is written to the project directory and a simple schematic is created. The schematic
contains only a NetlistInclude component that references the ADS netlist file. When an ADS simulation is run, the
simulator automatically reads the new netlist. This saves a lot of time on very large circuits both in translation
time and simulation time, since the schematic creation and traversal are both skipped. For information on Netlist
Options , refer to Defining Netlist Options. For information on editing the netlist, refer to Viewing and Editing the

Netlist.

17
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e Wires (Available from command line only) This translation method also writes an intermediate file in the IFF
format. After the IFF file is created, it is read by ADS and the schematic is created. For detailed information on
how this works, refer to Understanding the Import Operation. Components are placed and wired with a special
algorithm. The larger the file is, the slower this will be. This method should only be used on very small circuits.

Import Methods

Method Advantage Disadvantage When to Use
ADS Schematic (with Fast, easy to read Can be difficult to tell Default--use in most cases
named connections) which components are

connected together

ADS Netlist Allows large circuits to be Cannot edit the Large netlists that do not
modular components of the netlist require editing through Ul
through UL
Wires (available from For small circuits, easy to Slow, messy for large Small netlists
command line only) tell which components are  circuits

connected together
! Caution
It is highly recommended that the ADS Netlist option be used when translating large netlist file. In addition to

taking many hours to create a schematic from a 20,000 line netlist, a schematic of that size is practically
non-editable.

For the purpose of the ex1.sp example, select the Named Connections method and click OK in the Import Netlist
Options dialog box. You are returned to the Import dialog box. Click OK to begin the translation.

Examining the Output

This section describes some of the information to look for during and after your translation to help you determine
whether your translation is complete or not.

Viewing the Status Window

While the translator is running, a Status window appears and displays messages about the translation as it progresses

(see Example Status Window Contents). When the translation is complete, the Status window displays the message,
Translation completed, along with date and time done.

Example Status Window Contents

Netlist Translator (*) 210.day May 11 2002

18
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IFF translation log

Input format: PSpice

Input filename: ../projects/spectreExample/ex1.sp
Output format: IFF file

Output filename: spice.iff

Special options:

Processing first line as comment.

Begin translation at Thu May 1615:23:08 2002
Creating schematic with named connections.
Reading item definition file "/ADS_INSTALL/config/spctoiff.cfg"
Translation completed at Thu May 1615:23:09 2002.

Beginning IFF import
Processing IFF file: spice.iff
Creating design ex1

IFF import complete

The Status window reports information such as the input file format, the input file name and the output format. The
output format for Advanced Design System is the IFF file in this case. The translation start time is also displayed.

After the translation is complete, check to see if there were any error or warning messages reported. If any errors or
warnings are displayed in the Status window, refer to Troubleshooting for information on unexpected results from the
Netlist Translator and how to fix the problem.

Viewing the Schematic

Open a new schematic window and then open the ex1.dsn design to view the schematic. For more information on
schematic windows, refer to "Working in Design Windows" in the ADS Schematic Capture and Layout manual.
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—| [ spice_pri ] ex1 (Schematic):3
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ADS Schematic Window with Translated ex1.dsn.

Before simulating your design in ADS, you will need to place simulation control blocks from one of the simulation
palettes in the schematic window. You may also need to place an instance of an imported design in a new schematic.

For more information on setting up your simulation, refer to Simulating the Translated Netlist.
Defining Netlist Options

If you selected ADS Netlist in Choosing the Translated Output Format, the Optional Directory Location area of the
Import Netlist Options dialog is activated. Specify the component name (use all lower case), number of pins and an

output directory in each of the respective fields, according to the guidelines below.
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=| Import Hetlist Options

Input Hetlist Dialect
PSPICE

® First line is a comment
| Suppress name mapping

Translated Output Format

1 ADS Schematic (with named connections)

# ADS Hetlist

Optional Directory Location

Directory To Store ADS Metlist . ) )
(defaults to project directory) — Optional Directory Location
Browrse...
Element Replacement Table
: Element Replacement
Table Field
OK Cancel Help

¢ Directory to Store Netlist To specify the path of the directory you want to store your netlist in, click Browse. The

Netlist Directory Selection dialog appears. If you do not choose a directory to store your netlist, it will default to
your current project directory.
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—| Metlist Directory Selection |

Filter
wnplesfads_prj/projectsiexample 1_prjf

Directories Files

s _prj/projectsfexample 1 .
Is_prjjprojectsfexample 1 prjf..

Selection

amplesfads_prifprojectsiexample 1_pri{

OK Filter Cancel Help

e Element Replacement Table If you created a custom component in Advanced Design System that you want the
system to use when it imports a netlist in place of the default ADS component, see Using a Custom Component
for instructions on completing this field.

Once all options are entered, click OK. You are returned to the Import dialog box.

Click OK on the Import dialog box. The following informational dialog appears:
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- Hetlist subcircuit component selection:8

=

Since you have selected an ADS netlist import. you
will need to select the proper component name from
a list of subcircuits awailable in your netlist,

A dialog will appear that will list all of the
subcircuits and you will be able to chooze from
the list,

Mote: if your netlist file iz large, it may take a
few moments to read the subcircuit references,

]

OK Print Help

The informational dialog informs you that you have selected an ADS netlist import and that you will need to select a
subcircuit from your netlist to be the top level circuit that will used for the simulation.

Click OK on the informational dialog to select the subcircuit. The following dialog appears:
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=| Metlist Subcircuit List:8

omponents with 0 pins

QPEL103 with 4 pins
QPEL10X16 with 4 pins
QPEL10X4 with 4 pins
QPEL10XE with 4 pins
QP6L1 PSS with 4 pins
QPGLZ0S with 4 pins
QP6LINXZ S with 4 pins
QP6L3I0XAS with 4 pins
QPEL3IS with 4 pins
QPELSS with 4 pins
QPHP1 with 4 pins
QPHP1E with 4 pins
QPHPZ with 4 pins
QPNP4 with 4 pins
GPHP8 with 4 pins
D17PSL17PS with 3 pins
V10L30 with 3 pins
VZ0L30 with 3 pins
VZ0LE0 with 3 pins
VD10L150 with 3 pins
VDZ20L240 with 3 pins
VI0L30R with 3 pins
RpL with 3 pins

RpH with 3 pins

CapDM with 3 pins
DiodeMWellSht with 2 pins
CapMIM with 3 pins

Ind with 3 pins

IndZ with 3 pins

oK Cancel Help

All of the existing subcircuits with their pin counts are listed.

 Note

Only the subcircuits from the Spectre or SPICE netlist that you entered in the Import dialog are listed. If you
want to use a subcircuit that is contained in an include file, you have to manually add that after the import

process is complete.

Select the subcircuit to use as the top level subcircuit and click OK to start the translation.
The Netlist Translator performs the automatic translation of your source file into an ADS Netlist plus an ADS
Schematic with a NetlistInclude component (see ADS Schematic Window with NetlistInclude Component.).
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ai [ spice_prj | QPEL10S (Schematic):6 BE

File Edit Select View Insert Options Tools Layout Simulate Window Cadence

DesignGuide Help
+

ESEREECE R R R EE.
[LumPEd—Cannnﬂnt%. S _|[ |{}| —'—|EIEJ_|E|

[

d

T - - - - - owt- - - - - 1 Port
[ P2 - - - - - F3 Fci-
Hm-1 Hima? Him=3 M=
| % | ol | [
| 3elect: Enter the starting point D items wire 0.8750, -3.2500 -2.3750,

ADS Schematic Window with NetlistInclude Component.

Viewing and Editing the Netlist

If you selected ADS Netlist in Choosing the Translated Output Format, the Netlist Translator creates an ADS netlist
and places it in the project directory. The ADS netlist is in the form filename .net, where filename is the component

name you specified in the Import Netlist Options dialog box.

To view and edit the netlist, open the ADS text editor from the Main window, Tools > Text Editor . You can also view
the netlist from a command shell or with any ASCII text editor. Translated ADS Netlist (ex1.net) displays the

translated ADS Netlist, ex1l.net , of the example file, ex1.sp.

Translated ADS Netlist (ex1.net)

; *SIMPLE RTL INVERTER

V_Source:vcc n4 0 Vdc=5 Vac=0

V_Source:vin nl 0
V_Tran=pulse(time,0,50,2e-09,2e-09,2e-09,3e-08)
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Vdc=0 Vac=0

R:rb n1 n2 R=10k

modql:ql n3 n2 0 Area=1 Region=1 Mode=1

R:rc n3 n4 R=1k

model modql BJT NPN=1 PNP=0 Bf=20 Tf=.1n Cjc=2p Rb=100 RbModel=1
SweepPlan:Planl Start=0 Stop=5 Step=0.1

DC:DC1 SweepPlan="Plan1" SweepVar="vin.Vdc" UseSweepPlan=yes
Tran:Tranl StopTime=100n StartTime=0 MaxTimeStep=1n

Once you have your netlist displayed, verify that the translated netlist and the original netlist have the same
parameters. For more information on parameter mapping in devices and models, refer to Translating a Device and
Translating a Model.

Using Imported Designs in ADS

This section provides additional information that can help you prepare for simulating your imported designs in
Advanced Design System. Depending on your specific needs and the way your translation was performed, you may be
required to perform these steps before your design can be simulated. For information on simulating your design, refer

to Simulating the Translated Netlist.
Checking for Unconnected Nodes

If the log file reported any components that could not be translated, there will be open connectors which show up as
red diamonds on the pins in the schematic. Pins that have a red diamond when the schematic is complete are not
connected to any other pins. To check for unconnected nodes on a large schematic where the red diamonds are hard
to see:

1. From the schematic window, choose Options > Check Representation . The Check Representation dialog box is
displayed.

2. Ensure the Unconnected pins check box is active and then click OK . A Check Representation Report is displayed

that will list all unconnected pins. Note that the components with unconnected pins are highlighted on the

schematic.

In the Check Representation Report , click Print to save the report to a file. Click OK to clear the dialog.

4. To clear the highlighted components on the schematic, choose Layout > Clear Highlighted > Components .
If a pin is not connected, it may be because the component it was connected to was not included in the original
file. More likely, the translation of that component failed because of a syntax error or there is no equivalent ADS
component. In this case, you should manually place a component and connect them using the Insert > Node
Name command.

w

A message will be written to the translation log file (nettrans.log) in the case of any failures. For more information on
the translation log, refer to Viewing the Translation Log.

) Note

There is no visible indication of unconnected nodes in the output ADS Netlist, so the log file must be checked
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for the names of un-translated components.

Including Models and Subcircuits

This section describes how to include models and subcircuits in your existing design using several example files.
Before continuing, create the two example files shown in Transmission Line Subcircuit (tline.sp) Netlist and
Transmission Line Inverter (inverter.sp) Netlist. Save each of the files in the project directory that was used for
storing the example SPICE netlist (ex1.sp) in Accessing the Import Dialog.

The two new example SPICE files make up a simple transmission line inverter. The first SPICE netlist (tline.sp) is a
subcircuit.

Transmission Line Subcircuit (tline.sp) Netlist

*TRANSM SSI ON- LI NE SUBCI RCUI T
. SUBCKT TLINE 1 3

T1 1 2 3 4 Z0=50 TD=1. 5NS

T2 2 0 4 0 Z0=100 TD=1NS

. ENDS TLI NE

. END

The next SPICE netlist (inverter.sp) includes additional components that complete the transmission line inverter
design.

Transmission Line Inverter (inverter.sp) Netlist

*TRANSM SSI ON- LI NE | NVERTER

V1 1 0 PULSE 0 1 0 0.1NS 0.1NS 20NS 40NS
RL 1250

R2 4 0 50

Import both of your new SPICE files individually using the information in Importing a Netlist File Using the User
Interface. These two files should be imported using the PSpice dialect and the Named Connections import method.
Remember to close all designs before starting each import.

After the designs have been imported, leave the design inverter.dsn open. Notice the red diamonds on this schematic
indicating that something is missing from the file. In some cases, this is caused by components that could not be
translated (see Checking for Unconnected Nodes). In this case however, the original SPICE file did not supply this
component so the tline.dsn subcircuit will be used to complete the circuit.

Including a Subcircuit
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Your SPICE netlist may contain one or more subcircuit definitions. A subcircuit in the SPICE file becomes a reusable
component in the ADS schematic. To use a subcircuit, you can place an instance of it in a new or existing design.

To browse for a component and include it in your design:

1.

From the schematic window, choose Insert > Component > Component Library or click the Display Component
Library List button on the toolbar. m

The Component Library/Schematic dialog box is displayed.

In the Libraries field, scroll down in the list until you find either the Spice Netlists library or the Sub-networks
library.

Click either the Spice Netlists library or the Sub-networks library in the Libraries field to see the list of subcircuits
that can be placed as components.

In the Components field, click the Component that you want to use ( tline in the example case) and move the
cursor back into the schematic window.

Click to place the component in your schematic.

Click the End Command And Return to Select Mode icon from the tool bar to stop placing instances of your

component. g |

If you know the name of the subcircuit without looking it up, you may type it directly into the Component History
drop-down list box as illustrated below.

= — r oa

Options Tools Layout Sin

70 | s ISR

Component History
Drop-down List —  tling

When you enter the name of the subcircuit in the component history box, the case must match exactly with the design
name in ADS. Your subcircuit name will be all lower case unless you checked the Suppress name mapping option in
the Import Netlist Options dialog box. For more information on capitalization and name mapping, refer to
Understanding Capitalization and Suppress hame mapping:

i)

Note

If your SPICE netlist contains a set of models outside of any subcircuit block, the models will be placed in a
separate top level design that has the same name as the SPICE file. To use these models, copy them into the
design that references them. Optionally, a design with models only can be placed as a subcircuit within another
design, but all of the models have to be edited to have global scope. To do this, select a model, open the edit
parameter dialog, click the Component Options button and change Scope to Global .
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Example Spectre Subcircuit with Referenced Parameter Value

The following example illustrates a translation of a Spectre subcircuit into an ADS netlist. The Spectre subcircuit
contains two parameters with default values. The value of the second parameter, r2 , refers to the first parameter, r1
. (The value of r1 could either be the default value or a specified value when the subcircuit is called from an instance
component.)

ADS does not directly support parameter default values that reference values of other parameters passed into the
subcircuit. Using the backward compatible option (-bc), the Netlist Translator manages this by placing extra variables
(in this example, ADS_r2_1, ADS_r2_2, and UNDEF) and an equation(s) within the netlist to calculate the correct
value of the contingent parameter (in this example, r2 ). Without the -bc option, ADS will read the subckt statement
with parameter referencing in Spectre syntax. Thus the subckt header is wrapped with the lines si nul at or

| ang=spectre and si mul at or | ang=ads.

© Note

Tnom is added by default to resistor component to match Spectre simulation results. This is done only when no
Tnom parameter is set.

© Note

This is only available through the command line. Use the -pp (preserve parameter) option.

Spectre subcircuit

subckt nyexanmple \(tl1l t2 s\)
paraneters rl=1 r2=r1l

RO \(t1 netl\) resistor r=rl
Rl \(netl t2\) resistor r=r2
ends nyexanpl e

ADS subcircuit-translated in backward compatibility mode (using -bc option)

define nyexample \(t1l t2 s\)

paraneters r1=1 r2="UNDEF"

ADS r2_0=r1

ADS r2_1=if \(r2 == "UNDEF"\) then ADS r2_0 else r2 endif
R RO t1 netl R=rl Tnon¥27

R Rl netl t2 R=ADS r2_1 Tnom=27

end nmyexanpl e

ADS subcircuit-translated in default mode (without using -bc option)
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si mul at or | ang=spectre
subckt nyexanple \(tl t2 s\)
paraneters rl=1 r2=rl

si mul at or | ang=ads

R RO t1 netl R=rl1 Tnon¥27

R Rl netl t2 R=r2 Tnomr27
end myexanpl e

Connecting a Component

This section describes how to set pin humber preferences and assign node names in order to connect a subcircuit to a
design. After placing the instance of the Transmission-Line Inverter subcircuit in the last example, you can use the
ADS Node Names to connect the subcircuit pins to the rest of the circuit. You may need to turn the pin number
visibility on to help identify the proper pins when naming nodes.

To set the Pin Numbers schematic preference in order to see the pin numbers:

1. From the schematic window, choose Options > Preferences . The Preferences for Schematic dialog box is

displayed.
- Preferences for Schematic:1 |
«f  Select Grid/Snap | Placement |  PinfTee Entry/Edit  Component Text| Jp
FiniTee
Size Color Visibility {onfoff)
P connected Pins
Pin Units
B Tee
.0s schem unit J
— I tiode voltage X Connected Pins
- Pin Current ¥ Fin Numbers
Tee Units - Node Name —I Pin Hames
.os schem unit ¢ ‘ Unconnected Pins use Highlight
Color defined in Display page
OK Apply Reset Save... Read... Cancel Help

30




Advanced Design System 2008

2. Select the Pin/Tee tab.
3. Click the Pin Numbers check box in the Visibility (on/off) section to activate the pin number visibility.
4. Click OK to save the settings and close the dialog box.

Defining the Node Names

To define the node names to connect the subcircuit:

1. Choose the Insert > Wire/Pin Label menu selection or click the Insert Wire/Pin Label icon in the tool bar.
HAME

The Wire/Pin Label dialog box appears.

Wire/Fin Label

Enter wire label and click the wire or pin

To create a bus or bundle, use the following syntax:
Bus - basename<start:stop[incr]> Ex: A<0:3=
Tapped wire - basename <index> Ex: A<0=
Bundle - wire [abel|bus, wire_labellbus,... Ex: A,B.C OR A<0:3-B

7 Close Help i

2. Enter n2 in the Node Name field but DO NOT click the Done button. An instance of n2 is attached to your cursor.

Drag your cursor onto the schematic and click pin 1 of the subcircuit symbol.

4. In the Node Name dialog box, change the node name to n4 . Again, DO NOT click the Done button. Drag your
cursor onto the schematic and click pin 2 of the subcircuit symbol.

5. Save your new design as tline_inv.dsn.

w

This completes the circuit. Your combined inverter.dsn and tline.dsn should now appear similar to the tline_inv.dsn
schematic design shown in Translated Schematic with Subcircuit (tline inv.dsn). This design is used in the simulation
example in Simulating the Translated Netlist.
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[ spice_prj ] Yine_inv (Schematic )8 | -i.l|
Select View Insert Options Tools Layout Simulation Window |-|a|p|
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Translated Schematic with Subcircuit ( tline_inv.dsn )

Creating a Hierarchical Project

You can create hierarchical projects using the Include/Remove Projects command. This command creates a reference,
or link to another project.

If the import has produced a set of models or subcircuits that will be maintained in a project directory other than the
one a designer will be working in, that project directory should be included into the working project directory so the
simulator can see the imported items. The Include & Remove dialog can be accessed from the Main window. To
include a project directory:

1. Open the working project directory from which you want to reference designs in other projects.

From the Main window, choose File > Include/Remove Projects. The Include & Remove dialog appears.

3. Use the File Browser to locate and select the project you want to include. This would be the project containing
the set of models or subcircuits.

4. Click the Include button. The project is added to the Project Hierarchy listing.

5. Repeat as needed, then click OK.

N
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Using the NetlistInclude Component

If you selected ADS Netlist in Choosing the Translated Output Format, your translated schematic will contain a
NetlistInclude component. This section describes how you can view and modify the NetlistInclude component and then
use the component within another design.

The NetlistInclude component in this section is created by modifying and translating a previous example SPICE Netlist
into an ADS Netlist with a NetlistInclude component. The newly translated design is then used to show how you can
place an instance of your NetlistInclude component into another design and then simulate the design.

To setup and translate your example SPICE Netlist into an ADS Netlist with a NetlistInclude component:

1. Close any open designs. Choose File > Close All.

2. If it's not already opened, open your project that you created in [ "Importing a Netlist File Using the User

Interface" |Importing a Netlist File#1106823]. Choose File > Open Project.

From the ADS Main window, choose Options > Text Editor to open the ADS text editor.

4. In the text editor, choose File > Open and open the file tline.sp that you created in Transmission Line Subcircuit

(tline.sp) Netlist in Including Models and Subcircuits.

Choose File > Save As to save the file with a new name, tline2.sp.

6. Edit the new file to change the subckt name to TLINE2 as shown in the following table, then re-save and close
the new file.

w

b

*TRANSM SSI ON- LI NE SUBCI RCUI T
. SUBCKT TLINE2 1 3

T1 1 2 3 4 Z0=50 TD=1.5NS

T2 2 0 4 0 Z0=100 TD=1NS

. ENDS TLI NE

. END

7. From a blank schematic window, import the new file tline2.sp . In the Import Netlist Options dialog box, select
PSPICE as the Spice Dialect and ADS Netlist as the Connection Method For Schematic. If you need more
information on importing a SPICE file, refer to Importing a Netlist File Using the User Interface.
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=| Import SPICE Options:1

Input. Hetlist Dialect
PSPICE

= First line is a comment
| Suppress name mapping

Translated Output Format

ADS Schematic {with named connections)

& ADS Hetlist

Optional Directory Location

Directory To Store ADS Hetlist
(defaults to project directory)

Browse...

Element Replacement Table

oK Cancel Help

8. Click OK to exit the Import Netlist Options dialog box.
9. In the Import dialog box, click OK to translate the netlist. An information dialog appears that informs you to
select a subcircuit that exists within the netlist.

=| Metlist Subcircuit List:4 |
tlineZ with 0 pins
line with 2 pins

OK Cancel Help _

10. Select the tline with 2 pins from the Netlist Subcircuit List dialog box and then click OK.
Once your translation is complete, ADS displays a schematic window with the tline2.dsn that contains two ports
and a NetlistInclude component similar to the one in the following illustration.

34



Advanced Design System 2008

| | METLIST. INCLUDE - I :

T |
Metlistinclude1 File
IncludeFiles[1}=tlineriet -~ - ————— Parameter
S (tline2 net)

Two Ports

- -Pott - - - - -Pot - - - -
Pt . . . . _p2

CMym=1 . . . Mym=2

Design Containing Two Ports and a Netlistinclude Component

11. Note that the File parameter in the NetlistInclude component is called tline2.net. The translated file tline2.net is
now in the project directory and looks like the netlist in the following table. You can use the ADS text editor to

open and view the ADS Netlist.
Translated Transmission Line Subcircuit (tline2.net) Netlist

; *TRANSM SSI ON- LI NE SUBCI RCUI T

define tline2 (nl n3)

TLINA:t1 nl1 n2 n3 n4 Z=50 E=(1.5e-09)*360 F=1
TLINA:t2 n2 0 n4 0 Z=100 E=(1e-09)*360 F=1

end tline

To view the design details of your NetlistInclude component:

1. From the schematic window, choose File > Design Parameters. The Design Parameters dialog box appears. The
General tab is displayed by default.
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— Design Parameters:3

Hame: | tline2

Description
tlines

Component Instance Name

&

Symbol Name
[SYM_2Port

Simulation
Model

Subnetwork

Library Name
Spice Netlists

Hirrate M

I

_I Allows only one instance

I Include in BOM

_| Layout Object

_| Simulate from Layout {SimLay)

OK Save SEL file

Note: An "*" indicates current project.

1 Copy Companent's Parametors

Artvrork
Type

synchronized

PR

Cancel Help

e The Name and Description fields display the current design name by default.

e The Component Instance Name field default is X. The text in this field is used as a prefix in building a
unique name (ID) for every item. This prefix becomes part of the annotation displayed with the symbol
representing the parametric subnetwork when you place it in a design.

¢ The Symbol Name field displays the standard symbol with the number of ports that you specified for the

circuit in the Import Netlist Options dialog.

e The Library Name field displays the name of the library that the design is owned by. This might be
something like Spice Netlists. For more information, refer to Including Models and Subcircuits.
2. Click the Parameters tab. The Parameters tab does not apply to this particular example; however, you may find
it helpful to understand the function of this dialog box for future reference.
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—| Design Parameters:3

Hame: | tline2

General :-I;a;'s-ur?u-aie-r:si

Select Parameter Edit Parameter
Parameter Hame

Value Type
Real

Default Value (e.g., 1.23e-12)
Optional
Parameter Type

Unitless

Parameter Description

¥ Display parameter on schematic

R Optimizabl
HAulcd La Fasip ® Allow statistical distribution
Add Multiplicity Factor -| Hot edited
Copy Parameters From... S LT
oK Save AEL file Cancel Help

When you import a SPICE file containing a subcircuit with parameters to an ADS schematic, you can use this tab
to view or edit the parameter details. Each parameter is listed in the Select Parameter field and has
characteristics that determine how it is handled when the network is reused. These include the Parameter Name ,
the Value Type assigned to the parameter, the Default Value , and optional control attributes. Default values are
listed only if they were specified in the SPICE file.

For more information on subcircuit parameters, refer to ".SUBCKT"]. For more information on using the Design

Parameters dialog, refer to "Defining Parameters" in the ADS Schematic Capture and Layout manual.
3. Click OK to continue.

To add an instance of your imported design:

1. Open the schematic tline_inv.dsn that was created as a result of Including Models and Subcircuits and shown in
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Translated Schematic with Subcircuit (tline inv.dsn).

Save the tline_inv file as tline_inv2.dsn using the File > Save As command.

In the tline2_inv schematic design, delete the tline component.

In this example, tline2 is the imported design with the NetlistInclude component. An instance of this component
can be placed in your tline_inv2 design by entering the name tline2 in the component history box. This attaches
an instance of the component to your cursor that you can now click into place. Place the instance of tline2 in an
appropriate location on the tline_inv2 schematic.

Options Tools Layout Simu

M2 0 D7 &

Comporent History .
Drop-down List — | tline]

Connect the appropriate circuitry to the new subcircuit by naming pin 1 n2 and pin 2 n4 . For more information

on naming nodes, refer to Defining the Node Names.

. This completes the circuit. This circuit can now be simulated using the example shown in Simulating the
Translated Netlist.

. ADVANCED OPTIONS

You may create your own symbol by drawing it in the symbol view ( View > Create/Edit Schematic Symbol ) and
changing the Symbol Name in the Design Parameters dialog to the name of the design, tline2 in this example.
Save the AEL file from the Design Parameters dialog and the design file from the File menu. A new symbol will
not automatically appear in the design in which it is used. For the new symbol to appear in your design, replace
the instance of tline2 in your test circuit.

additional information about the NetlistInclude component, refer to Adding the Netlistinclude Component.

Understanding Import Details

This section describes some of the unique details of the translation process that should be understood before
attempting to translate a design.

Using Valid ADS Characters
The legal character set for Advanced Design System names is alphanumeric _ + - = 2 '@ # & $ %. Legal characters
other than alphanumeric and underscore require special handling. Any string using special characters in ADS must be

enclosed by quotes. This is handled by the translator.

 Note

Do not insert extra quotes in your file. Additionally, $ and % are not allowed in subcircuit names since these
become invalid design and file names.
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If the translator encounters an illegal character (any character not listed above), the illegal character is replaced with
an underscore and a warning message is written to the log file.

Understanding Capitalization

Like Spectre, ADS is a case sensitive system, so Abc and ABC represent two different designs, components, etc. If the
Suppress name mapping option is not selected in the Import Netlist Options dialog, the translator converts all node
names, element and model names, variable names and subcircuit names to lower case. Conversion to all lower case
can cause a problem if the design being imported references an existing ADS design that has a mixed case name or a
name that is all capitals. In addition, this can case a problem if two or more items are referenced within the Spectre
netlist use case to differentiate between them, for example, two components named RS and rs.

Refer to Suppress name mapping: for information on toggling the Suppress name mapping option. For more
information on the command line option, refer to Importing a File from the Command Line. If this option is used, the
names in the file must use consistent capitalization; for example, every time Abc is used, it must be capitalized the
same.

Using Unique Names

The Spectre and SPICE simulators are less restrictive than ADS with regards to unique names. Model names must be
different than device names and the translator modifies the device name to help provide uniqueness.

The only other restriction is that a subcircuit cannot override the name of a built-in component. The translator does
not check for this at this time, since the library of parts is always growing and the translator is run as a separate
process from ADS.

e On UNIX, this should not be an issue because component names in ADS typically begin with a capital letter, and
any subcircuit name that is output by the translator will be in lower case. The exception would be if the Suppress
name mapping option were turned ON. For more information on the Suppress hame mapping option, refer to
Suppress hame mapping:.

e On a PC, this may present a problem in ADS because design names follow a case-insensitive rule (for this one
particular case). Because desigh names become file names and the file system is case-insensitive, a subcircuit
could potentially attempt to override a built-in component.

If there is a situation where the name of the subcircuit is the same as the name of an existing ADS component,
the name of the subcircuit will be changed in the schematic created by the translator. This will not be the case if
the netlist option is used, which will lead to an error during simulation. The user is responsible for uniqgue names
in this situation.

Using Global Nodes
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Global nodes are node names which, when used at any level of the hierarchy in the circuit, will be connected to the
same node. In Spectre, you declare a global node in the following manner in a definition statement (the first node is
always assumed to be ground):

gl obal gnd VCCl1 VCC2
or
gnd! VCC1! vCe2!

Berkeley SPICE does not support global nodes and HSpice and PSpice have different implementations. In HSpice, a
global node in a definition statement is declared as:

. gl obal VCC1 VvCC2
In PSpice, it is just defined when used by putting $G_ in front of the node name:
$G VCC1 $G VvCe2

Global nodes are translated in the style of PSpice except that instead of special characters at the beginning, an
exclamation point is appended to the node name when it is used. In the example above, the node names become
VCC1! and VCC2!. Additionally, this must be quoted since the exclamation point is a special character to ADS, so it
becomes "VCC1!" and "VCC2!".

Advanced Methods for Importing Files

This chapter describes the procedures for Importing files into Advanced Design System using the Netlist Translator
from the command line. The methods described in this chapter are for advanced users who want to have the ability to
manipulate their netlist within a translation.

Performing your translation via the command line provides you with more flexibility in the process and more control
over the output. Some of the advantages of translating your Spectre or Spice file from the command line are listed
below:

e It enables you to check for errors midway through the translation.
¢ It enables you to modify the intermediate file before the schematic is created
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e It enables you to do batch processing with multiple files.
e It gives you access to advanced command line options not supported by the user interface.

The output of a Netlist Translator command line translation can be either an IFF file that is used to create an ADS
Schematic or an ADS Netlist.

Understanding the Import Operation

This section describes how the Netlist Translator software works when performing an import operation. It may be
helpful to understand these steps if you plan on importing your designs using the Netlist Translator from the command
line.

When the Netlist Translator performs an import, the software runs an executable program called nettrans. The
nettrans program reads the file and then writes either an IFF file, spice. iff , or an ADS netlist, spice.net , depending
on the connection method defined when setting the import options. If an IFF file is created, Advanced Design System
reads the IFF file and creates a schematic. If an ADS netlist is created, it is stored in ADS netlist format and placed in
a pre-specified directory. Any errors that occur during the translation are written to a file called nettrans.log . This file
records any components that could not be translated due to issues such as unrecognized syntax or incompatible
models.

Running the nettrans program from the command line enables you to modify the contents of the spice.iff file before
importing the file into Advanced Design System. Once you are comfortable with the output of the nettrans program,
you can simply perform an IFF import into ADS. The IFF importer loads the spice.iff file, generates the schematic and
writes any error messages or warnings to a log file called ifftolib.log. Alternatively, you could convert the output of the
nettrans program to an ADS Netlist. For information on how the import options are controlled from the command line,
refer to Executing the Nettrans Command.

For information on how the import options are controlled from the user interface, refer to Setting the Import Options.

For information on how the import options are controlled from the command line, refer to Executing the Nettrans
Command.

Import Options shows the different import options available when using the Netlist Translator. Depending on your
needs, you can choose between the various options for optimum translation results.
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Import Options

With all methods of translation, you should compare your results against your original netlist if the size of the file
permits. Once you are comfortable with your translation into ADS, place the appropriate stimulus and simulator
control elements and simulate your design as described in Simulating the Translated Netlist.

Importing a File from the Command Line

This section describes the details of setting up and operating the Netlist Translator from the command line.

 Note

It is recommended that only advanced users attempt to import files from the command line since it requires
knowledge of setting environment variables and working in a UNIX shell or DOS window.

Setting up the Nettrans Command

To set up the nettrans program for use from the command line:
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For Windows platforms:

1. Open an MSDOS shell.

2. Set your $HPEESOF_DIR environment variable to your ADS installation directory. For example,
set HPEESOF_DIR= <ADS_install_dir>

3. Set your PATH environment variable to include the $HPEESOF_DIR\bin directory. For example,
set path=C:\AdvDesSys\bin;%path%

4. Set the appropriate library path for your operating system. For example,
set shlib_path=$shlib_path:$HPEESOF_DIR\lib\win

For UNIX platforms:

1. Set your $HPEESOF_DIR environment variable to your ADS installation directory. For example, if using the Korn
shell enter:

export HPEESOF_DIR= <ADS_install_dir>

2. Set your PATH environment variable to include the $HPEESOF_DIR/bin directory. For example, if using the Korn
shell enter:

export PATH=$HPEESOF_DIR/bin:$PATH

3. Set the appropriate library path for your operating system. For example, if using the Korn shell.

For HP-UX operating systems (i.e. HP-UX 11 and 11i), enter the following:
SHLIB_PATH=$SHLIB_PATH:$HPEESOF_DIR/lib/hpux11

For SUN operating systems (i.e. Solaris 8 and 9), enter the following:
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$HPEESOF_DIR/lib/sun58

For Linux operating systems, enter the following:
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$HPEESOF_DIR/lib/linux_x86

Executing the Nettrans Command

The nettrans command uses the following general syntax:

nettrans input_filenane output_filename -{s2|s3|plh|pl} -{glulw} [-1] [-n]

For Spectre use the pl parameter followed by spectre . The following is command syntax specific to Spectre:
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spectre -{glulw {-bc} [-1] [-n] {-ip}

Simply entering nettrans at the command line with no parameters displays a detailed nettrans usage message.
Entering the nettrans -v command displays the translator version, while entering nettrans -adv displays the syntax for
the advanced options. The following table displays a listing of all parameters and definitions used by the nettrans

command.

Parameter Definitions for nettrans

Parameter
input_filename
output_filename
Input file type
-s2

-s3

-P

-h

-pl < dialect >

Output options

Other options
-1

-n
-V

-adv

Advanced options

-W

-k

Definition

The name of the SPICE or Spectre source file to read in.
The name of the IFF or netlist file to write.

Definition

Berkeley SPICE (2g6)

Berkeley SPICE (3c, 3e, 3f)

PSpice

HSpice

Generic (use for translating Spectre netlists, -pl spectre )
Definition

Create ADS netlist

Create schematic w/o wires (uses named connections)

Create schematic w/wires (not recommended on large
circuits)
(Available from command line only.)

Definition

First line is not a comment (used for library files or
model include files)

Do not perform any name mapping for conflict avoidance
Return the version of the Netlist Translator

View advanced options

Definition (available from command line only)

Create schematic w/wires (not recommended on large
circuits)

Create subcircuits for models at top level (used for
library files or model include files)
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-pp Preserve Spectre subcircuit parameters.

-ps Prefix string to be added to appropriate variables, model
names, and subcircuit names in an ADS netlist.
This is required to support a unique name space for
design kit creation.

-SC Suppress comments

-se Suppress ADS subcircuit equations from being moved
from the parameter list when translating Spectre netlists.

-si < include_file > Suppress Spectre components contained in include_file .
The full path must be specified.

-SW Suppress warnings to log file.

-wrap < int > Line length at which to perform line wrapping (must be
greater than 10, default=80).

-m < mapfile > Mapping file for user-defined components

-models Read HSpice Model Library and output one file per
.LIB/.END pair. Suppresses nested .LIB statements.
output_filename should be a file extension only.
ex: nettrans mix025.l net -h -g -models
-pl dialect: Pass in the dialect to be parsed by Perl
-u2: Create schematic w/o wires (uses named
connections)

Named Connections are read from log file so custom
symbols can be used. If connections are not made,
load ael file spcUtil.ael and run ael macro
spctoiff_connect_pins("wireLabels.log");

-u2 Create schematic w/o wires (use named connections).
Named Connections are read from log file so custom
symbols can be used. If connections are not made, load
ael file spcutil.ael and run ael macro
spctoiff_connect_pins("wireLabels.log") . The spcutil.ael
file can be found under
$HPEESOF_DIR/links/spice/spcutil.ael .

-bc Generate netlist syntax that is backward compatible to
ADS/RFDE 2004A.

-ip < include_path > Specify paths (separated by a comma ',') of included
netlist files.

Enter the appropriate nettrans command from the command line to translate your Spectre file. Once the nettrans
command is complete you can view the output.

Additional Options Information
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Using the -n Option

If the -n option is used, names are not mapped to the lower case. If case mixing was used in the file, the variable,
instance and model names will not be converted to lower case. For more information on case sensitivity and name

mapping, refer to Understanding Capitalization.
Using the -pp Option

ADS does not directly support parameter default values that reference values of other parameters passed into the
subcircuit. This option will introduce logic in the translated netlist to manage reference values. See Example Spectre
Subcircuit with Referenced Parameter Value for an example using the -pp option.

Using the -se Option

Without this option, any Spectre parameters that reference a previous parameter in the subcircuit list will be pulled
out of the subcircuit list and treated as an ordinary equation in the subcircuit. This option allows you to keep these
parameters in place. Some manually editing is required to allow the netlist to simulate without errors.

Using the -si Option

The -si <include_file> option will translate a Spectre netlist with only a portion of the netlist outputted.
The information in the include file is used by the translator for model type resolution and other post processing needs.
The contents of that file will not be output in the translated ADS netlist.

Using the -models Option

An HSpice library or model file can consist of hundreds of models, defined within a .LIB section. Each .LIB section
defines one model , which may consist of a complete subcircuit. If this library file is referenced by a SPICE circuit file,
only the libraries that are used will be translated. However, the user may want to translate the complete model library
to a set of ADS netlist files. The -models option is available for this purpose.

To translate the complete model library in a file called mix025.1, invoke the translator from a shell command line as
shown in the following example.

nettrans mix025.1 net -h -g -models

The HSpice file is read and, for every .LIB section found in the library file, one ADS netlist file is output. The name of
the library which is specified in the .LIB statement becomes the name of the ADS netlist file. An extension is given on
the command line when the translator is invoked, and this is appended to the file name. In this case, the file
extension is net. A library designated by .LIB resistor will be translated to an ADS netlist file called resistor.net.
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Using the -u2 Option

When the -u option is used, connections in a schematic are made by naming nodes. This is done by placing a node
name on each pin. The translator makes these connections by reading a configuration file that contains pin locations
for all the element symbols that the translator uses. Subcircuit symbols are plain boxes with the appropriate number
of leads and pins on them.

If you have defined a custom symbol for any element, and the pins are not in the location expected by the translator,
some of the pins may not be named. Unconnected pins show up as red diamonds in the schematic. This will most
likely happen when a custom library part exists in ADS and is referred to in a file. The translator does not create the
subcircuit but is expected to connect to it.

When the correct pin information is not available to the translator in the spctoiff.cfg file perform the following steps:

1. Use the -u2 option from the command line as shown in the following example.
net t rans source_file . sp output_file .iff -h -u2
The translator will output the IFF file output file_ .iff and another file named wireLabels.log.

2. Import the IFF file from the user interface (refer to, Importing an IFF File).
This will create a schematic with no connections. To complete the connections, make sure the component
placement is satisfactory. There should be sufficient room between each component to display the parameters
and the node names.

3. Save all designs in which you made changes.

4. Make sure the file wireLabels.log is in your project directory and enter the following commands on the AEL
command line:

| oad(strcat (HPEESOF_DI R, "links/spice/spcutil.ael"));
spctoi ff_connect _pi ns("w reLabel s. | 0g")

When the macro has finished running, the pins will all be labeled with node names and all connections will be made as
specified in the Spectre file.

Using the -ip Option

The -ip < include_file > option enables you to specify either an absolute or relative path to a file that is included in a
Spectre netlist. You can specify multiple paths separated by commas ( , ).

Example

The test_ip.scs file:

library test.cap_mm
section typ
paranmeters cap_m m scal e=1
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include cap_m m ckt
endsecti on
endl i brary

The included cap_mim.ckt file:

inline subckt cap_m m (TOP BOT B\)
paranmeters c=0 BPCap=0 BPArea=0 BPPeri m=0
cap_m m TOP BOT capacitor c=cap_m m4_scal e\ *c
cp BOT B capacitor c=BPCap

ends cap_mm

Given the Spectre netlist files test_ip.scs_ and cap_mim.ckt_ above, if you run the nettrans command with the options
shown below:

nettrans test_ip.scs test_ip.net -pl spectre -g -ip <pathl> <path2>

nettrans will search for the file cap_mim.ckt in the following order:

1. present working directory
2. <pathl>
3. <path2>

If you have a file in one or more of the above locations, then the first occurrence of the file cap_mim.ckt will be used.

The resulting ADS netlist test_ip.net would be created as follows:

;library test.cap_mm
#i fdef typ
cap_m m scal e=1

inline define cap_m m\( TOP BOT B\)
paraneters c¢=0 BPCap=0 BPArea=0 BPPeri m=0
C:. cap_mi m TOP BOT C=cap_nmni m scal e\ *c

C:.cp BOT B C=BPCap

end cap_mm

#endi f
;endlibrary

Checking the Netlist Translator Version Number

To determine the version of the Netlist Translator that you are running perform the following steps:

1. Open a UNIX or DOS shell.
2. Ensure your environment variables are set correctly. For more information on setting environment variables,
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refer to Setting up the Nettrans Command.
3. Enter the following command:

nettrans -v

The Netlist Translator displays the version number.

Netlist Translator, version <version_number>

Where <version_number> is the actual version number of the translator.

© Note

ADS Netlist Translator version 170. xxx or higher is required to translate Spectre files.

Viewing the Translation Log

The Spectre or SPICE to IFF translation log (see Example Translation Log File (nettrans.log)) contains important
information about the netlist translation, including any error or warning messages recorded during the import
operation. The translation log can be viewed using any ASCII text editor. To view the translation log file, open your
text editor and load nettrans.log.

If your log file displays any error or warning messages generated by the translator, refer to Troubleshooting. Using a
combination of the information in the log file and the information provided in the troubleshooting section, edit your
translated netlist and save the new netlist with your corrections.

Since the translation log is an ASCII based text file, you can easily save the file with a new name using the File >
Save As command for future reference.

SPICE to IFF translation log

Input format: PSpice

Input filename: ex1.sp

Output format: ADS Netlist file

Output filename: ex1.net

Special options:

Processing first line as comment.

Begin translation at Thu May 30 10:16:00 2002
Creating netlist.

Reading item definition file "spctoiff.cfg"
Translation completed at Thu May 30 10:16:03 2002.

#» Note The netlist to IFF translation log file (nettrans.log) is over-written each time a new translation is
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performed. To avoid over-writing the log file, save it with a new file hame.

Importing an IFF File

This section describes how to import Intermediate File Format (IFF) files, created by the nettrans command, into
Advanced Design System. The IFF importer loads the spice.iff file, generates the new ADS Schematic and writes any
error messages or warnings to a log file called ifftolib.log .

The Intermediate File Format (IFF) is an ASCII file that contains a simple, line-oriented command structure with a
fairly rich set of constructs. The format is machine- and application-independent, thus simplifying design data transfer.
For more information on Importing an IFF file, refer to " IFF Files " in the ADS Importing and Exporting Designs
manual.

Accessing the Import Dialog

To import your IFF file,

Choose File > Import from the Main window.
S | 1

=] Advanced Design System {Main) - | o]
File View Options Window Help
Hewr Project... : —

Epen Project... ﬁ EE|
Example Project...
Copy Project... l[:uttmDS_Test |

Delete Project...

Include/Remove Projects...

Archive Project...

Unarchive Project...

Hew Design...

Open Design...

Copy Design...

Delete Design...

4 Save Al d

File Import ! Close Al ,
menu selection— ymport...

Exit Advanced Design System... Alt+F4

The Import dialog box appears.
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Specifying the File Name

In the Import dialog box, choose the type of file to import, specify the filename, and supply other basic information
needed by the translator.

1. In the Import dialog box that appears, select IFF from the File Type drop-down list if it isn't already displayed.

2. To specify the path and filename of the file you want to import click Browse . The Import File Selection dialog
appears.

3. Double-click as needed to locate the directory containing your IFF file or enter the full path and file name in the
Selection field. By default, all files are listed that have the suffix appropriate for the chosen file format.

4. Select the IFF file you want to import and click OK . You are returned to the Import dialog box and the selected
filename appears in the field labeled Import File Name (Source) .

=| Import:4 |
File Type

IFF ‘| More Options...

Import File Hame (Source)

Browse...
Derfals Deign
e Dasag Mame {Destination)
i Browse...
y oK Cancel Help _

Setting the Import Options

In the Import dialog box, click More Options to define the IFF import options. The Import IFF Options dialog box
appears.
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|

Import IFF Options

_| Remove IFF File After Import

* Use layouts from libraries instead of building local copies from IFF file

Default Library Name For Library Parts

Log verbose messages

Synchronize ports to symbol using node name

hpeesof Lif

Trace Handling

@ Trace
_J Path

_J) Polygon

oK Cancel Help

i)

Note
The Import IFF Options dialog box that appears is dependent upon where you execute the IFF import from (i.e
ADS Main , Layout or Schematic window).

Set the Import Options:

1.

2.

Ensure the Remove IFF File After Import option is deselected. When selected, the IFF file is removed once it has
been successfully imported. The default option is deselected.

Set the Log verbose messages as desired. When this option is selected, all translation information is recorded in
the ifftolib.log file resulting in step-by-step description of what happened internally during your translation. This
option is primarily intended to be used as a diagnostics tool. The default mode for this option is deselected. Note
that error and warning messages will always appear in your status window regardless of this selection.

Ensure the Synchronize ports to symbol using node name option is deselected. This option resets the symbol pin
numbers to match port numbers based on the node name of the schematic port. By default, symbol pin numbers
are matched to schematic port numbers based on the port's instance name.

Check the Default Library Name for Library Parts field. This field is used for specifying the default library name.
When the IFF file does not specify a library name for a component that needs to be created, the library name
specified in this field is used. The IFF files that are created by the nettrans program specify the library SPICE
INPUT, so the library name in this field will not change the outcome of the import.

Note

The Default Library Name For Library Parts field is identical to the field of the same name in the Export IFF
Options dialog box. Changes made to this field will modify the contents of the field in the Export IFF Options
dialog box.
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5. Accept the default Trace setting within the Trace Handling field. This field is normally used to enable you to select
how you want layout traces interpreted during a translation. Because the Netlist Translator does not support
layout import and export, this field is not used.

6. Click OK to save your settings or Cancel to retain the default settings. You are returned to the Import dialog box
and the selected filename appears in the field labeled Import File Name (Source) .

7. Click OK to import the IFF file into ADS. The IFF Importer performs the automatic translation of your IFF file into
an ADS Netlist.

About Component Libraries

A component library in ADS consists of a collection of component definitions. Each primitive component has an
associated component name, symbol and predefined component parameters that include relevant physical and
electrical characteristics.

The IFF translator can be used as the initial step in creating an ADS component library; however, this topic is outside
of the scope of this manual. Creating an ADS component library using IFF requires specialized tools and training. If
you are interested in learning more about this topic, contact Agilent EEsof-EDA's Solution Services.

Adding the NetlistInclude Component

In Advanced Design System, you can insert a saved netlist file into an ADS simulation via an include statement by
using the NetlistInclude component. The NetlistInclude component is used to link the netlist that was translated into
an ADS netlist, to the ADS schematic capture environment at the time of simulation.

The NetlistInclude component enables you to accomplish the following:

¢ Add parameter definitions, equations, and special sub-circuits from your design to the Advanced Design System
schematic.

¢ Initialize technology dependent model parameters or variables in a file that can then be automatically inserted
into the ADS netlist.

¢ Allow sectional includes to handle corner case analysis.
You can use a NetlistInclude in the following placements:

e In the top level of hierarchy, if the included file contains subcircuit definitions (it can contain an entire model
library)

¢ In any circuit, if the included file contains only variables and/or model cards
A NetlistInclude component referencing a file containing subcircuit definitions cannot be placed on a schematic
that is not at the top level of hierarchy, unless you do the manual steps defined below.

Manual Translation and Placement of a Netlistinclude Component

© Note
For ADS 2004A and ADS 2003C, these steps are only necessary when doing manual translation and placement
of the NetlistInclude component. When using the user interface for a translation to an ADS netlist, the

ITEM_NOSUBNET_HEADER_EX field is set by the translator.
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Suppose you have a top level design that includes a component abc and a DC simulation component. If the subcircuit
named abc contains a NetlistInclude component that references a file with a subcircuit xyz , the resultant netlist would
look like the following:

define abc (in out)
define xyz (input output)
paranmeters Rl

R Rl i nput output R=R1l
end xyz

end abc

abc:x1 _netl O

DC. DC1

In ADS, the nested define statements ( xyz defined within the definition of abc ) would cause an error such as the
following when simulated:

Error detected by HPEESOFSI M during netlist parsing.
In file "netlist.log' at, or just before, line 7.
Syntax error in conponent call
define xyz (input output)

To avoid this situation, you must manually modify the AEL item definition for the subcircuit. Discussion of item
definitions is beyond the scope of this manual. Please refer to the Advanced Design System AEL manual.

If you have a basic understanding of the item definition, you can proceed to modify the Extra item attribute, which is
field 15 in the create_item() function. To find this function, go to the networks subdirectory of your project directory
and edit the ael file that has the same name as the design ( abc in this example). This field needs to be set to
ITEM_NOSUBNET_HEADER_EX. This tells the ADS netlister not to put the define and end statements around the
contents of the subcircuit. This will cause another problem in that abc will not be defined at all now. To avoid this
situation, abc should be defined in your original Spectre netlist.

 Note
If it is at all possible, avoid placing a NetlistInclude component that references a file containing one or more
subcircuits anywhere other than the top level of your design hierarchy.

Placing a NetlistInclude Component

If you imported your netlist using the command line, you will need to insert a NetlistInclude component in your new
schematic.

To place a NetlistInclude component in an ADS schematic:

1. Select the Data Items component palette from the ADS schematic window.
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2. Click the NetlistInclude component to place the component on the schematic. An instance is attached to your
cursor. Place the component instance on the schematic as desired (click to place).

—| [ spice_prj | untitied1 * {Schematic):6 | 4]
File Edit Select View Insert Options Tools Layout Simulate Window Cadence
DesignGuide Help

I|IIIIIIII|
]

I8 b AMD 5 5 e O
Data Items il MNetlistinclude | {}l _Ll ml QJ _| Ml

o

L

NETLIST INCLUDE
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The NetlistInclude Component

3. You can continue to place component instances or choose the Cancel Command And Return To Select Mode icon
to proceed with the next step. [; |

4. To edit the netlist specifications choose Edit > Component > Edit Component Parameters or click the
NetlistInclude component on the schematic.

A dialog box appears, enabling you to specify the parameters of the file to include. See the table Parameter
Definitions for the NetlistInclude Component for a description of each parameter.

 Note

You can also click the line to be changed directly in the schematic instance and edit as desired.
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Hetlistinclude
Instance Hame

NetlistIncludel

Select Parameter

IncludeFiles[1]=
UsePreprocessor=yes
Space-delimited search path for ir

I

I Display parameter on schematic

fgid £ Pasts Component Options...

dePath : Space-delimited search path for included files

7 oK Apply Cancel Reset Help

Parameter Definitions for the NetlistInclude Component

NetlistInclude Parameter

Description

IncludePath=

IncludeFiles=

UsePreprocessor=

Using a Custom Component

Specifies the space-delimited search path for included
files.

Specifies the list of files to include.

Specify "yes" to use a #include directive, or "no" to copy
the full text of the file (default is "yes").

If you have created a custom component in Advanced Design System that you want the system to use in place of the
default ADS component when it imports a Spectre netlist, you must create a translation table in the Import Netlist
Options dialog box that specifies which custom component to use.
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Creating a Translation Table

A translation table is simply a two column table that does the following:

e Specifies a standard ADS component (left-hand column) and the custom ADS component (right-hand column)

used to replace it

e Specifies the standard ADS component parameters (left-hand column) and the custom ADS component

Advanced Design System 2008

parameters (right-hand column) used to replace them
To create the translation table perform the following steps:

1. Begin your normal import operation. See Importing a Netlist File Using the User Interface.
2. When you are Defining Netlist Options using the Import Netlist Options dialog box, enter the translation table in

the Element Replacement Table field.

Custom Component
Information

Import SPICE Options:1

Input Hetlist Dialect
PSPICE

¥ Frstline is a comment
| Suppress name mapping

Translated Output Format

JADS Schematic (with named connections)

&4 ADS Metlist

Optional Directory Location

Directory To Store ADS Metlist
(defaults to project directory)

il fusers/ocrscott/spice prijs

Element. Replacement Table

R MYR
+R RES

oK Cancel

Browsse...

Help
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Refer to the Example Translation Table for an example of how to format the information in the Element Replacement
Table field.

Example Translation Table

# Standard ADS Conponent Cust om ADS Conponent

# +Standard ADS Conponent Paraneter Cust om ADS Conponent Par anet er
R MYR

+R Res

+Tnom T

Comment Character - The system recognizes the pound sign ( # ) as a comment character. Note that the first two
lines in Example Translation Table are comments used to describe the elements of the table.

Component - Both the standard ADS component ( R ) and the custom ADS component ( MYR ) are given in line 3 of
Example Translation Table. On import, any time the translator would normally place the R component in ADS, the
system will place a MYR component instead.

 Note

The component name ( R ) in the left-hand column is not the Spectre name. It is the ADS component that
would be placed if the table were not used. Performing the import first, without the mapping, will allow you to
see the name of the component to be replaced.

Component Parameters - Component parameter mappings are listed one per line following the component name. Each
parameter line starts with the + character. List only the parameters that are unique to the custom component. It is
not necessary to list the parameter names on the custom component that are the same as the ADS component; the
translation automatically matches the correct parameters.

The only limitation on import is that new items have a similar symbol to the replaced component so that the
placement and wiring of the schematic work correctly. This means that the custom symbol should be approximately
the same size as the default component, and the pins must be in the exact location on the two symbols. If the pins
are not in the same location, the -u2 option must be used. For more information on the -u2 option, refer to Executing
the Nettrans Command.

To access the component mapping functionality while running the translator from the command line, use the -m
option. You create the file from scratch or modify the spice.map file that is created in the project directory when an
import is performed from the user interface. For more information on using the -m option, refer to Executing the
Nettrans Command.

Example Netlist Translation

The following shows an example comparison of how the system might translate a SPICE netlist to an ADS netlist with
or without the custom component defined in Example Translation Table.
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Using the Example Spice Netlist in Netlist Comparison, if no custom component was defined, the translator would
generate the ADS Netlist (without mapping). Using the translation table in Example Translation Table, the resultant
ADS netlist would appear as in the ADS Netlist (using a translation table) in Netlist Comparison.

Netlist Comparison

SPICE Netlist ADS Netlist(without a mapping) ADS Netlist (using a translation
table)
R1 1250 Thom=27 R:r1 n1 n2 R=50 Thom=27 MYR:rl nl n2 Res=50 T=27

) Note If your file contains functions that are not Advanced Design System functions, refer to Using Non-ADS
Functions.

Modifying the Translator Configuration File

The translator configuration file, spctoiff.cfg , is a file that is used when the translator creates a schematic. It is stored
in $HPEESOF_DIR/config. This file contains pin locations and sizes for the symbols of all the components that the
translator knows how to translate.

Since the Netlist Translator runs as a separate process from ADS (see Understanding the Import Operation), the
translator cannot determine this information on the fly. Periodically, symbols will be updated but the translator
configuration file will not be updated at the same time. In this case, you can manually modify the file if needed to
avoid overlapping components in the schematic.

The file consists of a block of information for each component. The first component in the file is the Capacitor (C).

C20-0.6250.6251.5-3.2500

There are four lines that start with C. The C is followed by an integer number which indicates the number of pins on
the component. This is followed by an integer number that indicates the rotation in degrees of the component.

The next four fields define the *bounding box* of the symbol, calculated with the default settings for parameter
visibility. If you choose to make all parameters visible while editing the schematic or if you make the font of the
parameters larger than default, you may need to increase the size of the bounding box, or spread your components
out on the schematic.

The final two coordinates on the first line are ignored.

The following two lines are the pin information.
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00180 Pin 1 is located at 0,0 on the symbol (the origin) and
rotated to 180 degrees.

100 Pin 2 is located at 1,0 on the symbol and placed at 0
rotation.

In the rare case that this file needs to be modified, usually only the bounding box information would have to be
modified. If there seems to be a problem with the file, you can request an updated file from Agilent EEsof-EDA
Customer Support, or you can make a few simple changes yourself if it is needed urgently.

The file can be modified for your installation by a system administrator. For individual use, a copy of the file can be
placed in the user's $HOME/hpeesof/config directory. The file located in the user's directory will take precedence over
the system file. For command line execution or batch processing, the file can also be placed in the directory where the
translator is running.

e The bounding box of a symbol is the technical term for the rectangular space occupied by a symbol on the
schematic. The four coordinates given are the upper left corner and the lower right corner, when the origin of the
component is placed at 0,0 on the schematic. The origin of the component is the position that is tied to the
mouse when the drag image is visible. Where you click the mouse to place a component becomes the location
where the origin of the component is placed. This hot-spot is usually pin 1.

Importing an HSpice File from Cadence after Parasitic Extraction

HSpice files output from Cadence have been observed to have syntax errors that will not be corrected by the
translator. Some of these syntax errors need to be corrected manually before importing or they will cause the ADS
simulation to fail. Others may be corrected after the translation and before simulation.

Make the following changes to your ADS netlist or schematic before starting the import:

e Expressions are usually enclosed in single quotes. Occasionally, expressions have been observed to be enclosed
in double quotes, which are not valid. This must be corrected before the file can be translated or the translator
will drop part of the expression.

Make the following changes to your ADS netlist or schematic after the import has completed:

e Values have been observed with non-matching pairs of parentheses. These will be passed through the translator
but cause the simulator to fail. This can be fixed prior to translation or prior to simulation.

e Files have been observed with multiple declarations of the same variable. All will pass through the translator but
cause an error in the simulator. Parameters should be declared only one time. Remove the extra parameters and
re-simulate.

e Subcircuit calls have been seen with parameters that were not declared on the subcircuit when it was defined.
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Again, the translator will not check for this error but the simulator will halt with an error. Remove the extra
parameters and resimulate.

Using Non-ADS Functions

If your file contains functions such as gauss() or pwr() or any other function that is not a built-in ADS function, the
simulator will give an Unresolved reference error.

Look for the function in the supplied function file:
$HPEESOF_DIR/links/spice/spicefunction.net (for SPICE functions)

The function can be copied into the ADS netlist, placed in the schematic, or the whole file can be included by entering
the following line in the ADS netlist:

#include "< path >/spicefunctions.net" (for SPICE functions)

Replace < path > with the correct location for your system.

For Spectre translations you do not need to do anything special. Any functions that are listed in the spectrefunc.rul file
will automatically be substituted into the new ADS netlist after translation.

Simulating the Translated Netlist

Once your netlist is successfully translated into Advanced Design System, you can simulate your new circuit in ADS.
This chapter discusses some of the details involved in circuit simulation and provides references to other sources. The
example used in this chapter refers to the Transmission-Line Inverter design created in Including Models and
Subcircuits.

Example SPICE Design

The following two example SPICE files make up a simple transmission line inverter. The first SPICE netlist (tline.sp) is
a subcircuit.
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*TRANSMISSION-LINE SUBCIRCUIT
.SUBCKT TLINE 1 3
T11234270=50TD=1.5NS
T22040Z0=100 TD=1NS

.ENDS TLINE

.END

The next SPICE netlist (inverter.sp) includes additional components that complete the transmission line inverter
design.

*TRANSMISSION-LINE INVERTER

V11 0PULSEO 10 0.1NS 0.1NS 20NS 40NS
R11250

R2 40 50

The resultant file from the import process is called tline_inv.dsn . See Importing a Netlist File for more information.

 Note

Although tline_inv.dsn is a design translated from SPICE netlists, the simulation steps and concepts described
in this chapter are directly applicable to Spectre imported designs.

Setting Up and Performing a Simulation

Setting up and performing a simulation in Advanced Design System requires several steps:

Opening the Schematic

Adding Simulation Components
Running the Simulation
Displaying the Results

PR

Opening the Schematic

To open an existing schematic design:

1. Choose File > Open Design in the ADS Schematic window. The Open Design dialog box is displayed. You can use
this dialog box to select the design you wish to simulate.

2. Choose the appropriate project from the Project drop-down list in the Open Design dialog box.

3. Click the appropriate design from the Designs list in the Open Design dialog box. (For this example the
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tline_inv.dsn file created in the Netlist Translator for SPICE manual will be used.)

4. Click OK to include the schematic in the ADS Schematic window.
For more information on opening designs, refer to, "Opening an Existing Design" in the Schematic Capture and

Layout manual.

Adding Simulation Components

After translating your netlist into Advanced Design System, you may need to add stimulus or simulation control
components to your design. In the schematic window containing the design you want to simulate, select the
appropriate simulation control elements from the component palette.

To add a simulation component to the tline_inv.dsn example:

1. Select the Simulation - Transient from the component palette. An instance of the TRANSIENT component is
attached to your cursor (see The ADS Simulation-Transient Component).
2. Using your mouse, locate the component to an appropriate area on the schematic and click to place the

component.
3. Click and edit the values of the StopTime and MaxTimeStep Tran parameters. For this example as follows:

e StopTime=40 nsec
e MaxTimeStep=.10 nsec

|$| TRANSIENT. I
e
Tran1
stopTime=40.0 nsec
MaxTimesStep=10 nzec

The ADS Simulation-Transient Component

For more information on using the Transient/Convolution Simulation component, refer to "Transient and Convolution
Simulation”.

Running the Simulation

Once you have added all of the necessary simulation components to your design, execute the simulation.
To run the simulation, choose Simulate > Simulate from the menu selection or click the Simulate button in the

toolbar. @|
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Simulation/Synthesis Message Window

The Simulation/Synthesis Message window appears whenever a simulator is launched and displays messages about
the status of the current process, as well as warning messages. The window contains two information panels:

e Simulation/Synthesis Messages
e Status/Summary

Simulation/Synthesis Messages

The Simulation/Synthesis Messages portion of the window displays detailed messages about problems encountered
during a simulation or synthesis, and where possible, what you can do to solve the problem.

File Simulation/Synthesis Text Window

Simulation / Syntheziz Messages

Warning detected by HPEESOFSIM during TRAM analysis “Tranl”.
Maximum timestep reduced to half of shortest transmizsion line de

& Hint
Watch for a message that prompts you to click to view the source of the problem. Clicking this message
highlights the component(s) (in the Schematic window) causing the problem.

Status/Summary

The Status/Summary portion of the window displays a Simulation finished message, statistics such as how long the
simulation or synthesis took, and the system resources used.
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Status f Summary

Simulation finished: dataset “tline_irw” written in:
“fhfs/dld local fusers/cracott/spice_prj/data”.

Resource usage:

Uzer time 3,20 zeconds,
System time 1.30 seconds,
Total CPU time 4.90 zeconds,
Simulation stopwatch time = 11.11 =seconds,

Stopuwatch time = 19.58 seconds.

Fhyzical memory uzed: 6.69 HBytes,

Viewing Simulation Status and Error Messages

When the simulation/synthesis is finished, you can save the displayed information to file or you can send it directly to
the printer.

To save the currently displayed information to file with a default filename:

Choose File > Save and click OK. The default filename consists of the simulation process number (from the title bar of
the window), with a prefix of the string sessloghpeesofsim and a file extension of .txt. The file is saved to the current
project directory.

To save the currently displayed information to a file with a different filename:

Choose File > Save As. Supply a filename and click OK. The file is saved to the current project directory.

 Note
If you have changed projects during the current session, the file may be written to the initial project opened in
this session.

To send the information directly to the printer:

1. If needed, choose File > Print Setup to establish the desired setup and click OK.
2. Choose File > Print. The displayed information is sent to the printer. For details on print setup, refer to "Printing
and Plotting" in the "Schematic Capture and Layout".

For more information on performing a simulation, refer to "Simulation Basics" in Using Circuit Simulators.
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Displaying the Results

After your simulation is complete, ADS automatically opens a Data Display window so that you can view your
simulation results. You can also open a Data Display window to see the results of a simulation analysis by choosing
Window > New Data Display from the Main or Schematic window. After a Data Display window is open, you can select

an independent swept variable, select dependent measurements, scale the data, and add captions to your graph. Then
you can print or plot the graph.

To view the results of the simulation in a plotted Data Display:

1. Choose the Rectangular Plot icon to drag and drop the plot frame in the Data Display window. @

The Plot Traces & Attributes dialog box appears.

= Plot Traces & Attributes:3

Flot Type | Plot Options

m e © 2B B

Datasets and Equations Traces
tline_inv . Yrace Cpia...

netin netin
netout netout
time sefigiden vsource
tranorder
vl.i \

|vsuurc:e wrfigh VR e n

caibiainaa

Hdvanced...

A OK Cancel Help

2. Select the dataset to display from the Datasets and Equations drop-down list ( tline_inv for this example).
3. To define the traces for display on your plot, individually double-click the data ( netin , netout and vsource for

this example) to add each item to the Traces field. Alternatively, you can select each item and then click the Add
button.

4. Click OK in the Plot Traces & Attributes dialog box. The graph is displayed in the Data Display window. Choose
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View > View All in the Data Display window to enlarge the plot to fit the display window.
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Transmission-Line Inverter Simulation Results

The preceeding illustration displays the simulation results for the Transmission-Line Inverter ( tline_inv ).

Analyzing and Comparing the Results

It is important to understand the results of your simulation to ensure that what you are looking at is not a result of
your netlist translation, but rather the results of your circuit design. You can analyze your data by using the various
tools available in the ADS Data Display, including a variety of plots, formats, markers and equations. For more
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information on working with data displays, refer to Data Display Basics.

After you understand your results, you can compare your ADS simulation results to your original HSpice simulation
results. Ideally, you would like to compare your Spectre simulation data against your ADS simulation data using the
same data file format; however, this is not always possible. There are two suggested methods that can be used to
compare your simulation results:

1. Visually compare your ADS Data Display output to the visual display output you have available in your simulator
tool. If you have the ability to output your data to an MDIF , Citifile or Touchstone file format, you can use the
Data File Tool to convert your data to an ADS Dataset and view it in the ADS Data Display.

2. If your Spectre simulation results are in ASCII text format, you can convert your ADS dataset to MDIF , Citifile or
Touchstone file format (ASCII text) and compare the data.

For more information on the different file formats, refer to Converting to an ADS Dataset.

) Note

Remember that Spectre and HSpice simulators use different simulator technology from the ADS simulator;
therefore, there may be incompatibilities between your file and the resultant ADS file that the translator was
unable to accommodate. Refer to Troubleshooting for more information.

Converting to an ADS Dataset

Ideally, you would like to compare your simulation data against your ADS simulation data in the same data display
format. One method of viewing your simulation data in an ADS Data Display is to convert your HSpice simulation data
into a common file format that ADS has the ability to read. Once your data is in an accessible format, you can convert
it to an ADS Dataset using the following table.

Data File Tool Supported File Types

File Type File Extension Description

ICCAP .ds Device under test (DUT), model
(MDL), and setup (SET) files from the
Agilent IC-CAP program. These files
can contain Measured, Simulated,
and/or Transformed data.

Touchstone File .S*p Touchstone data files are analog/RF
circuit component data files that
contain small-signal G-, H-, S-, Y-, or
Z-network parameters described by
frequency-dependent linear network
parameters for 1-, 2-, 3-, or 4-port
components. The 2-port component
files can also contain
frequency-dependent noise
parameters. For more detailed
information on the Touchstone file
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Citifile .citi

MDIF .p2d, .s2d, .t2d

format, refer to the ADS Circuit
Simulation manual.

The Common Instrumentation
Transfer and Interchange file ___
(CITIfile) format is a standardized
data format that is used for
exchanging data between different
computers and instruments. For
more detailed information on the
CITIfile format, refer to the ADS
Circuit Simulation manual.

Measurement Data Interchange
Format (MDIF) files are component
data files for the .p2d, .s2d, and .t2d
files.

For more information on the file formats listed above, refer to "Working with Data Files".

To use the Data File Tool to create an ADS dataset:

1. From the ADS Schematic window, choose Tools > Data File Tool. The dftool/mainWindow dialog box appears.
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In the Data File Tool dialog box, click Read data file into dataset.

Under File format to read , click the appropriate file format (i.e. Touchstone , MDIF, Citifile, or ICCAP ).
Under Input file name , click Browse to navigate file paths and select your Spectre simulation result file.
In the Dataset Name field, enter the name of the HSpice dataset.

When all of the above settings are entered, click the Read File button.

ouALN

For more information on reading files using the Data File Tool, refer to Reading and Writing Data Files.

Comparing Results

This chapter provides information on how to compare your translated design output results with your original netlist.
Once you have translated, verified and simulated your netlist, compare your ADS results with your original version.

Comparing the Schematic

For wired or unwired import options, compare your translated ADS Schematic with your original netlist. For a small
design, you can visually verify connections by matching node numbers. For information on nodes flagged with red
diamonds, refer to Checking for Unconnected Nodes.

To compare a larger schematic with the original netlist, first generate an ADS netlist. To generate an ADS netlist from
a schematic without starting a simulation:

1. Open the ADS command line from the Main window.
Choose Options > Command Line.
2. Enter the following command in the Command field:

de_netlist();

After applying this command, the netlist is stored in a file called netlist.log in the current project directory.

3. Proceed to the next section for instructions on how to compare the translated ADS netlist to the original netlist.

Comparing the Netlist

You can compare your translated ADS netlist to your original netlist to verify that nodes were connected correctly and
parameters were translated correctly. If you performed your translation from the command line and selected the -g
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option to create an ADS netlist, you can easily view and compare your translated netlist with your original netlist.

Since Spectre, SPICE, and ADS netlists are ASCII based text files, they can be viewed using any ASCII text editor. To
view the original netlist, open a text editor and load the file defined as input_filename in the nettrans command. To
view the translated ADS netlist, open a text editor and load the file netlist.log or the file defined as output_filename in
the nettrans command.

You can now compare your original netlist to the translated ADS netlist noting the differences between Spectre and
ADS.

Comparing Original and ADS Netlists

You can now compare your original netlist to the translated ADS netlist noting the differences between the original and
ADS. SPICE Netlist vs. Translated ADS Netlist shows an example comparison of a simple SPICE netlist translation. The
comparison is the same for Spectre.

SPICE Netlist vs. Translated ADS Netlist

# Original SPICE Netlist Translated ADS Netlist
1 BJT Curve Tracer Example ; BJT Curve Tracer Exanple
2 . param vce=0 i bb=0 vce=0
i bb=0
3 Vi 3 0 VCE V_Source:vl n3 0 Vdc=vce Vac=0
4 11 0 10 1 BB 11 0 10 I BB
5 QL 3 10 0 BJTML bjtm:ql n3 nl10 0 Area=1

Regi on=1 Mbde=1

6 .model bjtnl NPN model bjtml BJT NPN=1 PNP=0
RoModel =1 Tnonme27

7 .end

 Note

The numbers in the left hand column of SPICE Netlist vs. Translated ADS Netlist coincide with the numbers in
the descriptions below. Each nhumber references a line or group of lines in the adjacent netlist.

Here are some details you might notice in the translated netlist in SPICE Netlist vs. Translated ADS Netlist:

1. There is a semi-colon preceding the first line in the translated netlist. The translator inserted the comment
character even though there was no comment character in the SPICE file. This is because the SPICE simulator
always considers the first line of a SPICE file to be a comment. To override this behavior in the translator,
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deactivate the First line is a comment check box in the Import dialog or use the -I command line option.

2. The .param keyword in the SPICE netlist indicates the beginning of a parameter list. Each of the parameters
defined are written separately in the ADS netlist.

3. Components are indicated by a component designator (i.e. V_Source) followed by a colon and then a unique item
name (i.e. v1).

4. If a component references a model (bjtm1), the unique model name will be listed first, instead of a component
designator (V_Source).

5. The .model keyword in SPICE indicates the beginning of a model. The translator converts the SPICE model to an
equivalent ADS model.

6. The .end (end of circuit) command has no equivalent in the ADS netlist file. The translator stops reading after
encountering the .end command.

Now that you have compared your translated netlist to the original SPICE netlist and made some observations, you
can view the translation log (nettrans.log) to help understand some other reasons the translated netlist appears as it
does. For information on reviewing the nettrans.log file, refer to Viewing the Translation Log

Comparing Models and Devices

Compare each of your translated models and devices with those in your original netlist.

Model parameters are not always defined consistently for every simulator. There are differences between ADS,
Spectre and SPICE. Additionally, each simulator may use different equations in their model calculations. These
inconsistencies may lead to differences in simulation results for translated models.

If you have verified that the model parameters have translated as you expected by using the information in
Translating a Device and Translating a Model, and your simulation results are not what you expect, please contact
Agilent EEsof-EDA Customer Support for the latest information on model compatibilities. You may be asked to submit
your archived project to help resolve the issue.

For information on troubleshooting your translation, refer to Troubleshooting.

Comparing ADS Results to Hspice

Hspice uses different values for the physical constants k and q. This can subtly affect some of the temperature scaling
code. It can make small differences in kT/q, which is part of the equation for a forward biased diode.

Format Boltzmann's Constant k Electron Charge q
ADS Codata-86 1.380 658 0 x10 -23 1.602 177 33 x10 -19
Spice2, Spice3, Spectre 1.380 622 6 x 10 -23 1.602 191 8 x10 -19
Hspice 1.380 620 0 x 10 -23 1.602 120 0 x 10 -19
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Codata-98 1.380 650 3 x 10 -23 1.602 176 462 x 10 -19

Care must be exercised when comparing the currents flowing through reverse-biased PN junctions. A diode with
Is=1x10 -1 4 should have a current of -1x 10 -14 at -5V; instead it will show -5 x10 -12 . This is because ADS/Hspice
adds a small conductance of size gmin (nominally 1x 10 -12 S) in parallel with every reverse biased PN junction to aid
convergence. Thus if these currents are compared, all that is being compared is gmin and not the reverse-biased
diode results.

Troubleshooting Netlist Translator for SPICE and Spectre

This chapter provides information on possible translation failures from the Netlist Translator and how to resolve issues
that arise.

When an error occurs during a translation, an error message is written to the nettrans.log file. Sometimes, when
potential problems are found or the translator makes a change that the user needs to be informed of, warning
messages are also written to the nettrans.log file.

Debugging Imported Designs

Since no two design environments or simulators are alike, there may be problems that arise in the translation. Here
are a few tips for debugging the translation.

1. Read the log files. The log files are ASCII text files that contain valuable translation information.

e The nettrans.log file will always be present unless the translation completely failed. Running in a read-only
directory might cause this problem. This file will list any components that could not be translated.
Unrecognized syntax or incompatible models are the most likely causes of this problem.

e The ifftolib.log file will be present if a schematic output was requested. This file lists problems encountered
during creation of the schematic. For a summary of the import process, refer to Understanding the Import
Operation.

2. Choose the netlist output option. Since the netlist to netlist translation gives you an output file that is
human-readable, it is very easy to compare line by line with the source netlist. Even if you desire a schematic
eventually, this method can be used to debug the translation. For information on netlist comparison, refer to
Comparing the Netlist.

3. Output the netlist from ADS. First open the command line window from the ADS Main window.

Choose Options > Command Line.

Enter the command de_netlist();

This will create a file called netlist.log in the project directory. This is the information that goes to the simulator.
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If you are using a NetlistInclude component, the #include statement will be visible. To flatten that and show the
actual contents of the file, find the NetlistInclude component in the schematic and set its last parameter
NetlistDebugMode=0. Regenerate the netlist from the ADS command line.

4. The translator can be run manually from the command line using the nettrans command. For detailed
instructions on using the nettrans command, refer to Importing a File from the Command Line.

5. When debugging a very large file, the best thing to do is to break the file down into smaller pieces. Subcircuits
and include files can be imported one at a time; however, you should import the lowest level of hierarchy first so
the referenced design is created before it is used.

If the imported design appears to be syntactically correct and contains the correct data, but simulation results
are not as expected, please contact Agilent-EEsof-EDA customer support for the latest information on model
compatibility.

Error Messages

Invalid subckt line < number >, < line text >.
The translator has encountered a subckt line with unrecognized syntax. Correct the problem and rerun the translator.
Failed opening netlist file < name >.

The file specified by < name > was not found, or could not be opened. Verify that the file exists, and then check file
and directory permissions.

Failed opening output file < name >.

The file specified by < name > could not be opened for write. Check file and directory permissions. Make sure you are
not running ADS from a read-only directory.

Failed opening logfile nettrans.log.
The file net trans. | og could not be opened. Verify that the file exists, and then check file and directory permissions.

Fatal error in position ports ( ). OR
Node < name > missing from memory.

These are errors internal to the translator. Have your system administrator contact Agilent Technologies technical
support at eesof_support@agilent.com . In Canada and the United States, you can also call 1-800-473-3763.
Elsewhere, contact your local Agilent Technologies sales office.

Recursive subckt reference found in network < name >.
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A reference to subcircuit < name > was found in the subcircuit definition of the same name. A subcircuit cannot be
placed within itself.

Failed memory allocation.

Not enough memory to complete the translation; the file is very large, or has many subcircuits. Separate the file into
several smaller files and translate them individually. If needed, run the translation on a different machine

Found unmatched end of subckt at line <linenum>
An ends command was found but no subckt line corresponds to it. Correct the file and re-run the translation.
Invalid equation <eqn>

The translator failed parsing the equation while checking for reserved words or invalid characters. A complex equation
may need to be broken down into simpler equations that reference each other if no obvious errors are visible.

Warning Messages

ADS Netlist Translator could not find a definition for < instance name >. A valid definition for < instance name > is
required.

This warning is issued when the model/sub-circuit definition is not found. It might be that the definition is in the
included file (if any).

Item mapping file < name > not found.

The item mapping file specified by < name > was not found, or could not be opened. Verify that the file exists, and
then check the file and directory permissions.

Failed attempting to convert node voltage syntax for < varname >.
Variable reference not found.

For information on this warning message, refer to the comments under Capacitor Device or Resistor Device.
Failed opening include or library file < name >, line < number >.

The file specified by < name > was not found, or could not be opened. Verify that the file exists, and then check the
file and directory permissions.

Failed processing line < number >, < text >.
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Encountered syntax that cannot be translated. For more information on device, model and Command Line syntax,
refer to Translating a Device, Translating a Model and Translating Commands and Functions.

Skipping unsupported capacitor syntax PWL, line < number >.

Optional PWL syntax # capacitor was encountered and cannot be translated. See capacitor description Capacitor
Device.

Skipping unsupported inductor syntax PWL, line < number >.
Optional PWL syntax for inductor was encountered and cannot be translated. See inductor description Inductor Device.
Skipping unsupported source syntax < name >, line < number >.

Encountered source syntax that cannot be translated. See source descriptions Polynomial Voltage-Controlled Current
Source (pvccs), and Linear Voltage-Controlled Voltage Source (vcvs).

Skipping unsupported < name > syntax, line < number >.

Encountered syntax for item < name > that cannot be translated. For more information on device, model and
Command Line syntax, refer to Translating a Device, Translating a Model and Translating Commands and Functions.

Skipping unsupported 4-port JFET device < name >, line < number >.

Specified JFET is not available in ADS. See JFET description JFET Device.

Skipping unsupported model type < name >, line < number >.

Specified model is not available in ADS. See model descriptions Translating a Model.

Skipping unsupported statement < name >, line < number >.

Spectre < name > statement is unrecognized or unsupported. See control line descriptions Translating Commands and
Functions.

Skipping unrecognized element type: line < number >, < name >.

Element type is not one of supported elements for the selected Spectre type. For information on supported devices,
refer to Translating a Device.

Skipping unsupported element < name >.
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Encountered element < name > that cannot be translated. For information on supported devices, refer to Translating
a Device.

Invalid level < name > - skipping model < name >, line < number >.

Encountered unexpected level value for model < name >. See model descriptions in the Translating a Model.
Invalid library syntax - missing library name, line < number >.

See library syntax in the control lines section of library.

Model < mname > for device < name > in circuit < circuithame > not found.

Model referenced by device < name > is not found in the netlist. Check the names. Make sure the model is present
globally or in the specified circuit. The model may exist or be added later in ADS but the translator will still generate a
warning. If a model is not present in the file, the translator may not have enough information to place the proper
device (ex: NPN vs. PNP). You may need to correct the schematic or netlist before simulating.

Referenced circuit < name > not found.
A circuit was used that has not been defined. Make sure the circuit is defined in the file or ADS.

Schematic not created for subcircuit <name> with no translated components.
A design will not be created if there is nothing to put in it. Look for a message regarding untranslated components.

Appended <?>_ to <item> due to a conflict with a reserved word.

A partial list of Advanced Design System reserved words is listed in Partial Listing of ADS Reserved Words. The full list
is much longer. If the translator finds a node, element or variable name that is the same as a reserved word, the
name is appended with an _n, _e or _v respectively.

Partial Listing of ADS Reserved Words

abs db e In mag nf value
cO deg exp In10 max step y
cos delay i log min Y z

For more information on ADS reserved words, refer to Reserved Names and Name Spaces.

*,  Caution
The subcircuit "ckt_name" contained parameters that reference each other. In order to maintain compatibility
with ADS, these have been moved off the subcircuit parameters list and are treated as circuit equations.
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Component instances that reference this subcircuit will not be able to directly override these values.

The subcircuit ckt_name contains parameters that reference each other. The ADS netlist format does not support this
syntax. Any subcircuit equations that reference each other are moved from the subcircuit parameter list and they are
listed as subcircuit equations. Component instances that reference this subcircuit will no be able to directly override
these values.

Known Problems

Problem ADS simulation results do not match my original simulation.

Model differences exist between all simulators due to different default parameters and different equations. ADS
models are usually implemented exactly as specified in the Berkeley model. Differences that occur between ADS and
other simulators are beyond our control since the equations for these simulators are not published.

Problem I have a very large netlist with a number of included files.

If your set of files seems too large to be handled in one translation, the included files can be imported first. Design
files will be created for all subcircuits. Close all designs before doing the next import. If a referenced design has
already been imported, you can ignore the warnings from the translator and ADS that say the referenced design
cannot be found.

Problem Symbol and pin topology on subcircuits is hard-coded for schematic imports.

If a file contains references to a custom subcircuit, the pins will not be connected properly if the symbol is not the
standard nport symbol supplied in the design environment. This is only a problem for importing to a schematic (wired
or unwired). A work-around is available for the method that uses named connections (unwired). For more information
on working around the unwired method, refer to Using the -u2 Option. For more information on using Named

Connections , see Defining Netlist Options.

Problem Symbols in schematic overlap each other.

If symbol pins overlap, there can be problems with pins being left unconnected. This shows up as red diamonds on the
pins in the schematic. For information on correcting this situation, refer to the following sections:

e Checking for Unconnected Nodes
e Using the -u2 Option.

e Modifying the Translator Configuration File.

Problem Statistical blocks of the form below, are not supported by the Netlist Translator prior to ADS 2005A. With the
backward compatibility mode (-bc option), this block will be commented out.
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statistics {
m smat ch {

}
}

Problem Expressions of the form below are translated straight across and are not supported by ADS prior to 2005A:

| r=(pl ? p2+1 : p3+1)

| c=(pl==p2)

 Note

Expressions of the form, c=(pl==p2), can be translated to run in ADS releases prior to 2005A by using the
"-pp -bc" option. This is supported for Spectre only.

Problem Statistical parameters of the form % are not translated to the ADS "stat" format.

Problem Numeric pin names of the subcircuit and component instances in the input netlist are prefixed with _node in
the output netlist after the netlist translation.

Since _node is a reserved word for the un-named node in the ADS, you cannot connect this node to any other
node using named connection(Wire/pin label).

Translating a Device

This chapter provides device translation tables for each of the devices supported by the Netlist Translator.

Recognizing Device Identifiers

Each SPICE device is distinguished by the first letter in it's device name. The following table describes the device type
associated with each letter of the alphabet.

SPICE Device Table
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Device
AXXXXX
BxXxxxx
CXXXXX
DXxxXXX

ExXXxxXx

FXXXXX

GXXXXX

HXXXXX

Ixxxxx

JIXXXXX
KXXXXX
LXXXXX

MXXXXX

NXXXXX

OXXXXX

Pxxxxx

QXXXXX

RXXxxX
SXXXXX

TXXXXX

UXXXXX

VXXXXX

WXXXXX

Spice2

capacitor
diode

VCVS

CCCs

VCCs

CCvs

current

jfet
mutual
inductor

mosfet

bit

resistor

tran line

voltage
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Spice3 PSpice HSpice
dep source gaasfet
capacitor capacitor capacitor
diode diode diode
VCVS VCVS VCVS
cces cces cces
vCces vCces vCces
ccvs ccvs ccvs
current current current
jfet jfet jfet,mesfet
mutual mutual mutual
inductor inductor inductor
mosfet mosfet mosfet

digital

lossy tline digital
bjt bjt bjt
resistor resistor resistor
vc switch vc switch
tran line tran line tran line
rc line digital src lossy tline
voltage voltage voltage
ic switch ic switch
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Not translated

N type GaAsFET
Capacitor

Diode

Voltage-Controlled
Voltage Source

Current-Controlled
Current Source

Voltage-Controlled
Current Source

Current-Controlled
Voltage Source

I_Source (ADS
Netlist)

N or P type JFET
Mutual Inductor
Inductor

N or P type
MOSFET, also
with substrate

Not translated

Ideal Physical
Transmission Line

Not translated

NPN/PNP BJT,
VBIC

Resistor
Not translated

Ideal 4-Terminal
Transmission Line

2 Ideal
Transformers, 1
Ideal DRC

V_Source (ADS
Netlist)

Not translated
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XXXXXX subcircuit subcircuit
YXXXXX
ZXXXXX mesfet

Documentation Conventions

subcircuit subcircuit subcircuit
Not translated

N or P type
MESFET

To help you interpret the ADS and Spectre syntax given for a device, the following table describes the conventions

used in this manual.

Device Table Conventions

Description

Keywords, parameter names and other literals are in
bold.

Parameters and names that are replaced with values by
the user and are translated are in italics.

Optional items are enclosed in square brackets.

A choice between two or more items is displayed in
square brackets separated by vertical bars.

Repeated optional items are enclosed in square brackets
followed by an Asterisk.

Many parameters consist of name=value pairs; the left
side is a keyword (literal text), the right side is typically

a number, expression or variable (exceptions are noted).

Simple keywords and values must appear in the given
order, but name=value pairs may occur in any order.

Example:

Example

poly

nl

[ic=x]

[off | on]

[cn]*

ctank2 n1 n2 capacitor cO [ cn ]* [ic= x ] [tcl=y ] [tc2=z ] [ off | on ] [param= value ]*

Notes

e The example above is a capacitor with the name: ctank2

e The capacitor has two nodes: nl1 and n2
e The capacitor has a required keyword: capacitor
e The keyword is followed by a required value: cO
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The required value may be optionally followed by any number of values: [ cn ]*
There are three stated optional name=value pairs which may appear in any order: [ic= x ] [tcl=y ] [tc2=z ]
There is one set of optional keywords of which one may appear but not both:

[ off | on ]

There other name=value pairs which may appear in any order: [param= value ]*

 Note

When translating to the ADS Simulator, the node names, values and right hand sides of hame=value pairs
remain the same; however, the keywords may change to their ADS Simulator equivalents.

Using Parameter Mapping Tables to Understand a Translation

Device parameter information is organized in tables with the ADS parameter, unit, and default value in the three
left-hand columns of the table. The parameter translation information is described in the three right- hand columns.

The parameters that are not translated are included in the tables. The parameters under Parameters not in Spectre
Model are parameters that are supported in ADS and are not supported in Spectre. The parameters under Parameters
not in ADS Model are parameters that are supported in Spectre and are not translated to ADS.

Refer to the Advanced Design System Circuit Components manual for an alphabetical listing of ADS supported devices
and a detailed description of their parameters and default values.

Device Tables for Spectre

This section provides individual device translation information for each specific device supported by the Netlist
Translator. The following is a list of supported devices:

Resistor Device
Capacitor Device
Inductor Device
Mutual Inductors
Diode Device

BJT Device

MOSFET Device
JFET Device
Subcircuit Reference
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Controlled Sources

In Spectre-compatibility mode (default), all controlled sources are translated into Spectre netlist syntax. Therefore, a
controlled source in a Spectre netlist will be wrapped by si mul at or | ang=spectre and si nul at or | ang=ads in the
ADS netlist. For example, given the following Spectre netlist fragment:

f001r002 (98 194 ) cccs probe=v002 gai n=0. 013357

the information above would be translated into the following ADS netlist fragment:

si mul at or | ang=spectre
f001r 002 _node98 _nodel94 cccs probe=v002 gai n=0. 013357
si mul ator | ang=ads

In backward-compatibility mode (-bc option), all controlled sources are translated into ADS netlist syntax.
The device information for controlled sources in backward-compatibility mode (-bc option)

Linear Voltage-Controlled Voltage Source (vcvs)
Linear Voltage-Controlled Current Source (vccs)
Polynomial Voltage-Controlled Voltage Source (pvcvs)
Polynomial Voltage-Controlled Current Source (pvccs)
Linear Current-Controlled Current Source (cccs)
Linear Current-Controlled Voltage Source (ccvs)
Polynomial Current-Controlled Current Source (pcccs)
Polynomial Current-Controlled Voltage Source (pccvs)

Independent Sources

Independent Current Source (Isource)
Independent Voltage Source (Vsource)

BJT Device

The Spectre BIT device is translated as one of the following:

84


http://edocs.soco.agilent.com/display/ads2008/Linear+Voltage-Controlled+Voltage+Source+%28vcvs%29#LinearVoltage-ControlledVoltageSource%28vcvs%29-1109461
http://edocs.soco.agilent.com/display/ads2008/Linear+Voltage-Controlled+Current+Source+%28vccs%29#LinearVoltage-ControlledCurrentSource%28vccs%29-1115302
http://edocs.soco.agilent.com/display/ads2008/Polynomial+Voltage-Controlled+Voltage+Source+%28pvcvs%29#PolynomialVoltage-ControlledVoltageSource%28pvcvs%29-1114715
http://edocs.soco.agilent.com/display/ads2008/Polynomial+Voltage-Controlled+Current+Source+%28pvccs%29#PolynomialVoltage-ControlledCurrentSource%28pvccs%29-1114740
http://edocs.soco.agilent.com/display/ads2008/Linear+Current-Controlled+Current+Source+%28cccs%29#LinearCurrent-ControlledCurrentSource%28cccs%29-1130386
http://edocs.soco.agilent.com/display/ads2008/Linear+Current-Controlled+Voltage+Source+%28ccvs%29#LinearCurrent-ControlledVoltageSource%28ccvs%29-1130388
http://edocs.soco.agilent.com/display/ads2008/Polynomial+Current-Controlled+Current+Source+%28pcccs%29#PolynomialCurrent-ControlledCurrentSource%28pcccs%29-1130390
http://edocs.soco.agilent.com/display/ads2008/Polynomial+Current-Controlled+Voltage+Source+%28pccvs%29#PolynomialCurrent-ControlledVoltageSource%28pccvs%29-1130383
http://edocs.soco.agilent.com/display/ads2008/Independent+Current+Source+%28Isource%29#IndependentCurrentSource%28Isource%29-1131106
http://edocs.soco.agilent.com/display/ads2008/Independent+Voltage+Source+%28Vsource%29#IndependentVoltageSource%28Vsource%29-1131116

Advanced Design System 2008

e a nonlinear NPN or PNP BJT device
e a nonlinear NPN or PNP BJT device with substrate
e an NPN device
For information on the BJT model, refer to BJT Model (Bipolar Transistor Model).

Example Spectre Command Line:

gl (vcc net3 mnus) npn_nod regi on=fwd area=1 n¥l

Spectre Netlist Syntax:

name nc nb ne [ ns ] ** mname ** [param= value ]*

ADS Netlist Syntax:

BIT[4]:

mname : gid nc nb ne [ ns ] [param= value ]*

VBIC:
mname : gid nc nb ne ns [param= value ]*

ADS Schematic Symbols:
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BJT_NPN

BJT_PNP

Instance Parameters:
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w

-

}/
“a
-

EJT4_NF

= —

N VBIC_NPEN

-

}/
v
-

BJT4_PN

— -

=z

P VBIC_PNP

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

BJT Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default
Area 1.0 area 1.0
Region 0 (off) region fwd
NPN (see type model
parameter)
PNP (see type model
parameter)
_M 1 m 1
Parameters not in Spectre Model
Temp T °C 25
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Mode

on

Noise

on

Parameters not in ADS Model

trise °C 0.0
T Temp = trise + temp ("temp" is an ADS global variable)
VBIC Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Scale 1 area 1
Region on region fwd
NPN yes (see type model

parameter)
PNP no (see type model

parameter)
_M 1 m 1
Parameters not in Spectre Model
Temp T °C 25
Mode nonlinear
Noise on

Parameters not in ADS Model

trise °C 0.0

T Temp = trise + temp ("temp" is an ADS global variable)

Comments:

e The referenced [BJT_Model:Bipolar Transistor Model] is read to determine which device to use:

NPN keyword indicates BJT_NPN or BJT4_NPN
PNP keyword indicates BJT_PNP or BJT4_PNP

e If SCALE is specified, Value = Value * scale .
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e If trise is provided, Temp = trise + temp ( temp is an ADS global variable).

BXXXXXXX

Semiconductor GaAsFET Device: This device is translated as a nonlinear N-type GaAsFET device. For information on
the GaAsFET model, refer to [GaAsFET and JFET Models for SPICE].

Example SPICE Command Line:

bl 1 2 3 Bnodel 2

SPICE dialect and netlist syntax:

Spice2/3:|Non-linear dependent source - not translated|
PSpice: b id ** nd ** ng ** ns ** mname [ AREA ]
HSpice: Does not exist

ADS Netlist Syntax:

mname :b id ** nd ** ng ** ns Area= area

ADS Schematic Symbols:
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ks s

GaAskFET TOM
B1 B1

Instance Parameters:

bid = GaAsFET element name
mname = Model hame

nd = Drain node

ng = Gate node

ns = Source node

area = Area factor

Capacitor Device

The Spectre capacitor device is translated as an ADS capacitor device. For information on the capacitor model, refer to

C Model (Capacitor Model).

Example Spectre Command Line:

Without model referenced:
cl (1 0) capacitor c=2.5u w=2u | =2.5u tcl=1e-8

With model referenced:
cl (1 0) proc_cap c=2.5u w=2u | =2.5u tcl=1le-8
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Spectre Netlist Syntax:

Without model referenced:

name nl n2 mname [param= value ]*
With model referenced:

name nl n2 capacitor [param= value J*

ADS Netlist Syntax:

Without model referenced:

C: cid n1 n2 C= value [param= value ]*
With model referenced:

mname : cid nl n2 [param= value J]*

ADS Schematic Symbol:

| o

R
|

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Capacitor Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default
C F C F
TC1 1/°C tcl 1/°C 0.0
TC2 1/°C 2 tc2 1/°C 2 0.0
InitCond \Y 0.0 ic \Y 0.0
Length m | m
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Width m w m

M 1 m 1

Parameters not in Spectre Model

Temp T °C 25
Tnom °C

wBv W infinity
Model

Parameters not in ADS Model

trise °C 0.0

scale 1

T Temp = trise + temp ("temp" is an ADS global variable)

Comments:

e The value of C cannot be an expression that changes during the simulation.

o If trise is provided, Temp = trise + temp ( temp is an ADS global variable).

CXXXXXXX

Capacitor: This device is translated as a capacitor. For information on the capacitor model, refer to
[C_Model:Capacitor Model].

Example SPICE Command Line:

cl 1 2 1pF

SPICE dialect and netlist syntax:

Spice2/3: cidnlin2 [ valuemname ]J[I=1][w=w][ic=ic]

PSpice: cid n1 n2 [ mname ] value [ ic= ic ]

HSpice: cid n1 n2 [ mname ] [ c= ] value [[ tc1= ] tcl [[ tc2= ] tc2 ]] + [scale=scale] [ic=ic] [m=mult] [w=w]
[I=1] [dtemp=dtemp]
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ADS Netlist Syntax:

Without model referenced:

C:cid n1 n2 C=value [_M=mult]

With model referenced:

mname_:cid n1 n2 [C=value] [Length=I] [Width=w] [InitCond=ic]
+ [TC1l=tcl] [TC2=tc2] [Temp=temp+(dtemp)] [M=_mult]

ADS Schematic Symbol:

|y

R ey
|

C

Instance Parameters:

cid = Capacitor element name

mname = Model hame

nl = Positive node

n2 = Negative node

value = Capacitance in farads

| = Length in meters

w = Width in meters

ic = The optional initial condition (time-zero) value of capacitor voltage (in volts). The initial condition (if any)
applies only if the UIC option is specified on the .TRAN control line.

tcl = Temperature coefficient per degrees celsius.

tc2 = Temperature coefficient per degrees celsius squared.

scale = Element scale factor.

mult = Multiplier used to simulate multiple parallel devices.

dtemp = Element temperature difference with respect to circuit temperature.

Comments:
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HSpice: If the value of C is an expression which is a function of node voltages or independent variables, then the
component is a dependent capacitor. In ADS, the component is represented by a Symbolically Defined Device (SDD).

If one of the SDD parameters uses a variable containing node voltages, the translator needs to look up the node
voltages on the resultant SDD to convert them to the correct ADS syntax and update the variable expression. For
instance, the node voltage described as v(nodeX) in HSpice must be converted to _v1, if the first pair of nodes on the
SDD is (nodel, 0).

For translation purposes of this special case, the SDD and the variable used by it are expected to be defined in the
same subcircuit, with the variable being used by only one SDD. If the variable were defined globally or used by
different SDDs, the node voltage variables (_v1, etc.) might not match up correctly. For example, in the case
described above one SDD might have (nodeX,0) as the first pair of nodes (_v1), while another SDD might have
(nodeX,0) as the 2nd pair of nodes (_v2). The translator would not be able to replace v(nodeX) in the variable
expression to define both SDDs correctly at the same time.

If this SDD is not found in the same subcircuit as the variable expression, a warning message will be written to the log
file nettrans.log . Also, the expression will not be converted automatically, and it will have to be fixed manually before
simulation is attempted.

If SCALE is specified, Value=Value*scale

If dtemp is provided, Temp=temp+dtemp

Translator Limitations: Functionality is available in ADS but not yet supported by the Netlist Translator. Workarounds
are provided below.

HSpice:
1) Nonlinear capacitor cid n1 n2 poly c0 cl1 c2...

This is supported by ADS as a component called NonlinC. The ADS Netlist Syntax should be:

NonlinC:cid n1 n2 coef=list(c0 c1 c2...) [ic=ic]

2) cid n1 n2 c='equation' ctype=[0|1]

This syntax requires a Symbolically Defined Device (SDD) in ADS if ctype=0. This is not currently handled by the
translator. Please contact customer support for assistance in writing the SDD to represent the voltage across the
capacitor.

The Netlist Translator fails to recognize the capacitor model in the following syntax:
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cl 1 2 cmodel

The translator assumes that it is a variable name for the capacitance value. To correct your imported schematic,
manually move the model name to the parameter Model. To correct the ADS Netlist, use the following netlist syntax:

cmodel:cl 1 2 [param=value]*

Diode Device

The Spectre diode device is translated as an ADS diode device. For information on the diode model, refer to Diode
Model (PN-Junction Diode Model).

Example Spectre Command Line:

d0 (dp dn) pdiode | =3e-4 w=2.5e-4 area=1

Spectre Netlist Syntax:

name nl n2 mname [param= value ]*

ADS Netlist Syntax:

mname : did nodel node2 [param= value ]*

ADS Schematic Symbol:
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For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Diode Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Area 1 area
Periph 0 perim
Length m I m le-6
Width m w m le-6
Region on region on
_M 1 m 1
Parameters not in Spectre Model
Temp T °C 25
Mode nonlinear
Noise yes
Gd Siemens
Cd F

Parameters not in ADS Model

trise °C

scale 1

T Temp = trise + temp ("temp" is an ADS global variable)

Comments:

If trise is provided, Temp = trise + temp ( temp is an ADS global variable).
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DXXXXXXX

Semiconductor Diode: This device is translated as a nonlinear diode device. For information on the diode model, refer
to [BJT_Model:Bipolar Transistor Model].

Example SPICE Command Line:

dl 1 2 Drodel 2 OFF

SPICE dialect and netlist syntax:

Spice2/3: did n1 n2 mname [ area ] [ off ] [ ic= vd ] [ temp= temp ]

PSpice: d id n1 n2 mname [ AREA ]

HSpice: d id n1 n2 mname [[ AREA= area ] [ PJ= periph ]] [ W= wval L= Ival ]] + [ off ] [ dtemp= dtemp ] [
m=mult][ic=vd ][ pj=x][wp=x][lp=x]+[wm=x][Im=x]

OR

did n1 n2 mname [ area [ periph J]][ OFF ] [ IC=vd ] [ M= val ]

ADS Netlist Syntax:

mname : d id nodel node2 [[ Area= area ] [ Periph= periph ]| + [Width=wval] [Length=Ival]] [ Temp= temp| [
temp +dtemp ]\ ] [ _M= mult ]

ADS Schematic Symbol:
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Instance Parameters:

Did = Diode element name

mname = Model hame

nl = Positive node

n2 = Negative node

area = Area factor. If area is not specified and W and L are, area is calculated as Ival*wval.

periph = Scaling factor that affects the sidewall. If P] or periph is not specified, and W and L are, Periph is
calculated as 2*(wval + Ival).

Width = Geometric width of diode junction (meters).

Length = Geometric length of diode junction (meters).

EXXXXXXX

Linear Voltage-Controlled Voltage Source: This device is translated as a Symbolically Defined Device. For information
on SDD's, refer to Using a Symbolically Defined Device.

Example SPICE Command Line:

el 123420

SPICE dialect and netlist syntax:

Spice2/3:

e id n1 n2 cnl cn2 value

PSpice:

eid nl n2 cnl cn2 value
eid n1 n2 poly(1) cnl cn2 value
nonlinear: eid n1 n2 poly(n)...

HSpice:
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eid nl n2 cnl cn2 value
eid n1 n2 poly(1) cnl cn2 value
nonlinear: eid n1 n2 poly(n)...

ADS Netlist Syntax:

SDD:e id cnl cn2 n1 n2 I[1,0]=0 F[2,0]=_v2-( value *_v1)

ADS Schematic Symbol:

eid = Source element name
nl= Positive Node

n2 = Negative Node

cnl = Positive Controlling Node
cn2 = Negative Controlling Node
value = Voltage gain

poly() = Polynomial function

Comments:

The following syntax extensions are not supported by the translator. If these keywords or parameters are found,
component translation will fail and a warning message will be written to the translation log file.

PSpice:
TABLE, LAPLACE, FREQ, CHEBYSHEV

HSpice Keywords:
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PWL, AND, NAND, OR, NOR, DELAY, OPAMP, TRANSFORMER

HSpice Parameters:

MAX, MIN, SCALE, TC1, TC2, ABS, DELTA, IC, NPDELAY

FXXXXXXX

Linear Current-Controlled Current Source: This device is translated as a Symbolically Defined Device. For information
on SDD's, refer to Using a Symbolically Defined Device.

Example SPICE Command Line:

f1 vout 0 vnane 0.05

SPICE dialect and netlist syntax:

Spice2/3:

fid n1 n2 sourceName value

PSpice:

fid n1 n2 sourceName value

HSpice:

fid n1 n2 sourceName value

ADS Netlist Syntax:
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SDD:fid n1 n2 I[1,0]= value *_c1 C[1]="sourceName"

ADS Schematic Symbol:

SOD1P
fid = Source element name
nl = Positive Node
n2 = Negative Node

value = Transconductance (in mhos).
sourceName = Name of controlling source

Comments:

The following syntax extensions are not supported by the translator. If these keywords or parameters are found,
component translation will fail and a warning message will be written to the translation log file.

HSpice Keywords:

PWL, AND, NAND, OR, NOR, DELAY

HSpice Parameters:

MAX, MIN, SCALE, M, TC1, TC2, ABS, DELTA, IC, NPDELAY

GXXXXXXX
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Linear Voltage-Controlled Current Source: This device is translated as a Symbolically Defined Device. For information
on SDD's, refer to Using a Symbolically Defined Device.

Example SPICE Command Line:

gl 12 3 4 .1mvho

SPICE dialect and netlist syntax:

Spice2/3:

g id n1 n2 cnl cn2 value

PSpice:

g id n1 n2 cnl1 cn2 value

HSpice:

g id n1 n2 cnl cn2 value

ADS Netlist Syntax:

SDD:gid cnl cn2 n1 n2 I[1,0]=0 F[2,0]=_v2-( value *_v1)

ADS Schematic Symbol:
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Instance Parameters:

gid = Source element name

nl = Positive Node

n2 = Negative Node

cnl = Positive Controlling Node

cn2 = Negative Controlling Node
value = Transconductance (in mhos).
poly() = Polynomial function

Comments:

The following syntax extensions are not supported by the translator. If these keywords or parameters are found,
component translation will fail and a warning message will be written to the translation log file.

PSpice

TABLE, LAPLACE, FREQ, CHEBYSHEV

HSpice Keywords:

PWL, AND, NAND, OR, NOR, DELAY, VCR, VCCAP

HSpice Parameters:

MAX, MIN, SCALE, M, TC1, TC2, ABS, DELTA, SMOOTH, IC, NPDELAY

HXXXXXXX

Linear Current-Controlled Voltage Source: This device is translated as a Symbolically Defined Device. For information
on SDD's, refer to Using a Symbolically Defined Device.

Example SPICE Command Line:
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hl vout 0 vnane 0.05

SPICE dialect and netlist syntax:

Spice2/3:

h id n1 n2 sourceName value

PSpice:

h id n1 n2 sourceName value

HSpice:

h id n1 n2 sourceName value

ADS Netlist Syntax:

SDD:hid n1 n2 F[1,0]=-( value *_c1)+_v1 C[1]=" sourceName "

ADS Schematic Symbol:

SOD1P

Instance Parameters:

gid = Source element name
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nl = Positive Node

n2 = Negative Node

value = Transconductance (in mhos).
sourceName = Name of controlling source
poly() = Polynomial function

Comments:

The following syntax extensions are not supported by the translator. If these keywords or parameters are found,
component translation will fail and a warning message will be written to the translation log file.

HSpice Keywords:

PWL, NPWL, PPWL, AND, NAND, OR, NOR, DELAY

HSpice Parameters:

MAX, MIN, SCALE, TC1, TC2, ABS, DELTA, IC, NPDELAY

Independent Current Source (Isource)

The Spectre Isource device is translated as either an I_Source (ADS Netlist) or an ItUserDef (ADS Schematic).

Example Spectre Command Line:

il (in 0) isource dc=0 type=pul se del ay=10n val 0=0 val 1=500u peri 0od=450n rise=1n fall =1n
w dt h=200n

Spectre Netlist Syntax:

name si nk src isource [param= value ]*
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Example ADS Command Line:

I _Source:il in O Idc=0 |_Tran=pul se(tine, 0,500u, 10n, 1n, 1n, 200n, 450n)

ADS Netlist Syntax:

| _Source:iid n+ n- ldc=dcval | ac=pol ar(mag, phase) |_Tran=tranfunc

Independent Voltage Source (Vsource)

The Spectre Vsource device is translated as either an V_Source (ADS Netlist) or an VtUserDef (ADS Schematic).

Example Spectre Command Line:

vpul sel (1 0) vsource type=pul se val 0=0 val 1=5 peri od=100n rise=10n fall=10n w dt h=40n

Alternate example:

vpwll (1 0) vsource type=pwl wave=[1n 0 1.1n 2 1.5n 0.5 2n 3 5n 5] pwlperiod=5n

Spectre Netlist Syntax:

name si nk src vsource [param= value ]*

Example ADS Command Line:

V_Source: vpul sel _nodel 0 Vdc=1 V_Tran=pul se(tine, 0,5, 0, 10n, 10n, 40n, 100n)
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ADS Netlist Syntax:

V_Source:vid n+ n- Vdc=dcval Vac=pol ar (g, phase) V_Tran=tranfunc

Alternate example:

V_Source:vpw 1 _nodel 0 Vdc=1
V_Tran=pwl (5n, 1n, 0, 1. 1n, 2, 1. 5n, 0. 5, 2n, 3, 5n, 5)

IXXXXXXX

Independent Current Source: This device is translated as either an I_Source (ADS Netlist) or an ItUserDef (ADS
Schematic).

Example SPICE Command Line:

il12DC6

i223AC1 90

i3 30 PULSE(-1 1 2NS 2NS 2NS 50NS 100NS)

i4 30 SINO 1 100MEG 1NS 1E10)

i530 EXP(-4 -1 2NS 30NS 60NS 40NS)

i6 75 PW(0 -7 10NS -7 1INS -3 17NS -3 18NS -7 50NS -7)
i7 12 0 SFFM O 1M 20K 5 1K)

SPICE dialect and netlist syntax:

Spice2/3:

iid n+ n-[[ dc ] dcval ] [ ac [ mag [ phase 1]] [ tranfunc ]

PSpice:

iid n+ n- [[ dc ] dcval ] [ ac [ mag [ phase ]]] [ tranfunc ]

HSpice:
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iid n+ n- [[ dc]dcval ][ ac [ mag [ phase ]]] [ tranfunc ]

ADS Netlist Syntax:

I_Source:i*id n+ n- *Idc=*dcval *lac=polar(mag,phase) *I_Tran=*tranfunc

ADS Schematic Symbol:

ItUserDef

L‘x*/

L

Instance Parameters:

iid = GaAsFET element name

n+ = Positive node

n- = Negative node

dcval = The dc current

mag, phase = The magnitude and phase of the ac current.

tranfunc = Transient Source Functions. There are several built in ADS functions that mimic the SPICE transient source
functions listed below.

SPICE Advanced Design System

EXP() exp_pulse(time, low, high, tdelayl, taul, tdelay2, tau2)

PULSE() pulse(time, low, high, delay, rise, fall, width, period)

PWL() pwl(time, t1, x1,..., tn, xn)

SFFM() sffm(time, offset, amplitude, carrier_freq, mod_index, signal_freq)
SIN() damped_sin(time, offset, amplitude, freq, delay, damping)

HSpice

PU() pulse(time, low, high, delay, rise, fall, width, period)
AM() Not translated.

PL() Not translated.
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Comments:

HSpice:
HSpice multiplier on Current sources - This is implemented by making an expression out of the given current value.
Example:

HSpice: i1 n1 n2 500ua m=10
ADS: egn0=(500ua)*(10)
I_Source: i1l n1 n2 Idc=500ua*10

Unsupported HSpice transient functions - AM, PL

Unsupported HSpice syntax extensions -

Data driven PWL source

Repeat and Time Delay specifications in PWL transient function (R=repeat, TD=delay)

PSpice:
Unsupported PSpice syntax extensions

STIMULUS
corner points, TIME_SCALE_FACTOR, VALUE_SCALE_FACTOR

JFET Device

The Spectre JFET device is translated as either a nonlinear N-type or a nonlinear P-type JFET device. For information

on the JFET model, refer to JEET Model (Junction FET Model).

Example Spectre Command Line:

jk1l (netl net2 0) jnod area=1

Spectre Netlist Syntax:
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name nd ng ns [ nb ] mname [param= value ]*

ADS Netlist Syntax:

vcvs:name p n ps ns [param= value ]*

ADS Schematic Symbol:

1

]

‘P

s

JFET_MFET

Instance Parameters:

For information on parameter format, refer to

JFET Model Parameter Mapping

g

“g

s

JFET_PFET

Using Parameter Ma

ing Tables to Understand a Translation

ADS Name Unit Default Spectre Name Unit Default

Length m | m

Width m w m

Ad m 2 ad m 2

As m 2 as m 2

Pd m pd m

Ps m ps m

Nrd nrd m/m

Nrs nrs m/m

Region on region triode
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_M 1 m 1
Parameters not in Spectre Model
Temp T °C 25
NMOS yes
PMOS no
Mode 1
Noise yes
Parameters not in ADS Model
trise °C 0.0
Id m
Is m
degradation no

T Temp = trise + temp ("temp" is an ADS global variable)

Comments:

e The referenced [JFET_Model:Junction Field Effect Transistor Model] model is read to determine which JFET device
to use:

PJF keyword indicates JFET_PFET
NJF keyword indicates JFET_NFET

The 4-port JFET is not available in ADS. The device will be skipped.

If SCALE is specified, Value = Value * scale .

If trise is provided, Temp = trise + temp ( temp is an ADS global variable).

The following syntax bay be ambiguous to the translator if the referenced model is not in the translated files:

Jid nd ng ns varl var2

The translator is unable to determine which of the following should be used:
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Jid nd ng ns na nodel nanme

or

Jid nd ng ns nodel nane area

Since the 4 port device is not available anyway, it will assume that modelname and area are specified. A warning
message will be reported in the log file.

IXXXXXXX

Semiconductor JFET Device: This device is translated as either a nonlinear N-type or a nonlinear P-type JFET device.
For information on the JFET model, refer to [JFET_Model:Junction Field Effect Transistor Model].

Example SPICE Command Line:

j1 12 3 Jnmodel 2 OFF 1C=0.6, 5.0

SPICE dialect and netlist syntax:

Spice2/3:

jid nd ng ns mname [ area ] [ off ] [ ic= vds , vgs ] [ temp= x ]

PSpice:

jid nd ng ns mname [ area ]

HSpice:

jidndngns[nb]mname[areaw=wl=1][off ] [ m= mult]
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ADS Netlist Syntax
mname :j id nd ng ns [ Area= area ] [ Temp=temp +dtemp ] [ Region= 0]

ADS Schematic Symbol:

T T

" P "

N ks

JFET_MFET JFET_PFET

Instance Parameters:

jid = JFET element name

mname = Model name

nd = Drain node

ng = Gate node

ns = Source node

nb = optional bulk node - not supported.

area = Area factor

off = Initial condition on the device for dc analysis. Translates to Region=0.
mult = Multiplier used to simulate multiple parallel devices.

temp = Temperature at which the device is to operate.

Comments:

The referenced [JFET_Model:Junction Field Effect Transistor Model] model is read to determine which JFET device to
use:

PJF keyword indicates JFET_PFET
NJF keyword indicates JFET_NFET

The 4-port JFET is not available in ADS. The device will be skipped.
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If SCALE is specified, Value=Value*scale
If dtemp is provided, Temp=temp+dtemp

The following syntax bay be ambiguous to the translator if the referenced model is not in the translated files:

Jid nd ng ns varl var?2

The translator is unable to determine which of the following should be used:

Jid nd ng ns na nodel nane

or.

Jid nd ng ns nodel name area

Since the 4 port device is not available anyway, it will assume that modelname and area are specified. A warning
message will be reported in the log file.

KXXXXXXX

Coupled (Mutual) Inductors: This device is translated as a mutual inductor.

Example SPICE Command Line:

ki Ll L2 .5
L1 1 3 10
L2 2 4 20

SPICE dialect and netlist syntax:

Spice2/3:
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k id lid1 lid2 value

PSpice:

k id lid1 lid2 * value

HSpice:

k id lid1 lid2 [ K= ] value

ADS Netlist Syntax:

Mutual:k id K= value Inductorl="lid1 " Inductor2="lid2 "

ADS Schematic Symbol:

MUT T ND
N \

2
L2
Mutual L'I\/% .
K1 O\/?“
M

Inductor1="L1" .
Inductor2="_2" 3

Instance Parameters:

kid = Mutual inductors element name

lidl = Name of the first coupled inductor.

lid2 = Name of the second coupled inductor.

value = The coefficient of coupling, K, which must be greater than 0 and less than or equal to 1.

Comments:
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The ADS Schematic symbol for an individual inductor uses a slash on the wire near pin 1 as opposed to the standard
dot used in SPICE. Note that the MUTIND on the left is the symbol placed when the K is read. The example on the
right is an illustration of the referenced inductors.

For value, HSpice and ADS allows a coefficient of coupling between -1 and 1.

e PSpice supports a mutual inductor syntax that allows any number of inductors to be coupled together with the
same coupling coefficient. This needs to be converted to a set of mutual inductors representing every possible
combination of inductors from the list. The translator does not support this at this time.

Unsupported Syntax and Parameters

PSpice:

kid lid1 coupling value model [size]
kid Tlname T2name Cm=cval Lm=1val

HSpice:

HSpice model syntax
HSpice MAG parameter

Linear Current-Controlled Current Source (cccs)

The Spectre cccs device is translated as an ADS Symbolically-Defined Device (SDD).

Example Spectre Command Line:

Csl nl n2 cccs probe=v002 gai n=0. 013357

Spectre Netlist Syntax:

name p n cccs [param= value ]*
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ADS CCCS (SDD):

SDD: Gs1 n2 nl { 1]="v002" I[1,0]=-1*0.013357* c1

i)

Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

Linear Current-Controlled Voltage Source (ccvs)

The Spectre ccvs device is translated as an ADS Symbolically-Defined Device (SDD).

Example Spectre Command Line:

f001r002 ( 1 2 ) ccvs probe=v002 gai n=0.013357

Spectre Netlist Syntax:

name p n ccvs [param= value ]*

ADS CCVS (SDD):

SDD: f 001r 002 _node2 _nodel (1] ="v002" F[1,0]=(_v1)-(0.013357*_cl)

i)

Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.
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Linear Voltage-Controlled Current Source (vccs)

The Spectre vccs device is translated as an ADS VCCS device.

Example Spectre Command Line:

vl (1 0 2 3) vces gne-1 me2

Spectre Netlist Syntax:

name sink arc ps ns vccs ___ [param= value ]*

ADS Netlist Syntax:

VCCS: name nodel node2 node3 node4 [param= value ]*

© Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

ADS Schematic Symbol:

o i
< (v)z

- -

Instance Parameters:
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For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Linear VCCS Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

G Siemens 0.0 gm Siemens 0.0

Parameters not in Spectre Model

R1 Ohms 0.0 (Infinity)
R2 Ohms 0.0 (Infinity)
F Hz 0.0 (Infinity)

Parameters not in ADS Model

m 1

Linear Voltage-Controlled Voltage Source (vcvs)

The Spectre vcvs device is translated as an ADS VCVS device.

Example Spectre Command Line:

el (outl O pos neg) vcvs gai n=10

Spectre Netlist Syntax:

name p n ps ns vcvs [param= value ]*

ADS Netlist Syntax:

VCVS: name nodel node2 node3 node4 [param= value ]*
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 Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

ADS Schematic Symbol:

A -

R ‘_'l_ R2
&

L

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Linear VCVS Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

G V/V 0.0 gain V/V 0.0
Parameters not in Spectre Model
R1 Ohms 0.0 (Infinity)
R2 Ohms 0.0
F Hz 0.0 (Infinity)

Parameters not in ADS Model

m 1
LXXXXXXX

Inductor: This device is translated as an inductor.

Example SPICE Command Line:
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{{11 12 1pH IC=15mA

SPICE dialect and netlist syntax

Spice2/3:
I id n1 n2 value [ ic= icamp ]
PSpice:
I id n1 n2 value [ ic= icamp ]
HSpice:
lidnl n2 [ I=value ] [[ tcl= ] tcl [[ tc2= ] tc2 ]] [ scale= scale ]
ADS Netlist Syntax:
L:l'id n1 n2 L= value
ADS Schematic Symbol:

| Y o

L
L1

Instance Parameters:

lid = Inductor element name

nl = Positive node

n2 = Negative node

value = The inductance in Henries
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ic = The initial (time-zero) value of inductor current (in Amps)

tcl = First order temperature coefficient

tc2 = Second order temperature coefficient

scale = Element scale factor. Default=1.0.

mult = Multiplier used to simulate multiple parallel devices. Default=1.0

dtemp = Element and circuit temperature difference. Default=0.0

R = Resistance in ohms of the inductor element.

equation = The inductor value can be described as a function of any node voltages, branch currents, and any
independent variables such as TIME, frequency (HERTZ), or temperature (TEMPER). The type of variable L depends
upon is indicated by the parameter "LTYPE". Most commonly L depends upon I(Lxxx), which is assumed with the
default of LTYPE=0 as explained below.

LTYPE = If inductance L is a function of I(Lxxx), set LTYPE to 0. Otherwise, set LTYPE to 1. The inductance flux is
calculated differently depending on the value of LTYPE. LTYPE must be set properly to provide correct simulation
results. Defining L as a function of multiple variables is not recommended. Default=0.

poly() = Polynomial function

Comments:

If SCALE is specified, Value=Value*scale
Unsupported Syntax and Parameters

PSpice:

PSpice Inductor model is supported by ADS but not translated yet.
lid n1 n2 [mname] value

HSpice:

Nonlinear inductor lid n1 n2 poly 10 11 12...
This is supported by ADS as a component called NonlinL.

The ADS Netlist Syntax should be:

NonlinL:lid n1 n2 coef=list(10 I1 12...) [ic=ic]
lid n1 n2 L="equation' Itype=[0]1] [R=val]

This syntax requires a Symbolically Defined Device (SDD) in ADS if ltype=0. This is not currently handled by the
translator. Please contact customer support for assistance in writing the SDD to represent the current through the

121



Advanced Design System 2008

inductor.

MOSFET Device

The Spectre MOSFET device is translated as either a nonlinear N-type or a nonlinear P-type MOSFET device. For
information on MOSFET models, refer to [MOSFET Models].

Example Spectre Command Line:

nchl (1 2 0 0) nchmodl | =2u w=15u ad=60p as=37.5p pd=23u ps=6u
Spectre Netlist Syntax:
name nd ng ns nb mname [param= value ]*

ADS Netlist Syntax:

mname :m id nd ng ns nb [param= value T*

ADS Schematic Symbol:

1 1

] -

i >

5 &)

MOSFET _MKMOS MOSFET _PMOS

s
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Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Level 1 MOSFET Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Length m | m

Width m w m

Ad m 2 ad m 2

As m 2 as m 2

Pd m pd m

Ps m ps m

Nrd nrd m/m

Nrs nrs m/m

Region on region triode

M 1 m 1

Parameters not in Spectre Model

Temp T °C 25
NMOS yes
PMOS no
Mode 1

Noise yes

Parameters not in ADS Model

trise °C 0.0
Id m
Is m
degradation no

T Temp = trise + temp ("temp" is an ADS global variable)

BSIM3v3 Parameter Mapping
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ADS Name Unit Default Spectre Name Unit Default

Length m | m
Width m w m
Ad m 2 ad m 2
As m 2 as m 2
Pd m pd m
Ps m ps m
Nrd nrd m/m
Nrs nrs m/m
Region fwd region triode
Ngsmod ngsmod
_M 1 m 1
Parameters not in Spectre Model
Geo 1
NMOS yes
PMOS no
Mode 1
Noise yes
Temp T °C 25

Parameters not in ADS Model

trise °C
T Temp = trise + temp ("temp" is an ADS global variable)
BSIM4 Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Length |
Width w
Nf 1.0 nf 1.0
Sa 0.0 sa 0.0
Sb 0.0 sb 0.0
Sd 0.0 sd 0.0
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Min 0 min 0
Ad m 2 ad m 2
As m 2 as m 2
Pd m pd m
Ps m ps m
Nrd 1.0 nrd
Nrs 1.0 nrs
Rbdb rbdb
Rbsb rbsb
Rbpb rbpb
Rbpd rbpd
Trngsmod trngsmod
Acngsmod acngsmod
Rbodymod rbodymod
Rgatemod rgatemod
Geomod geomod
Rgeomod rgeomod
_M 1 m 1
Trise K 0 trise K
Model9 MOSFET Parameter Mapping
ADS Name Unit Default Spectre Name Unit Default
Length m le—4 | m 1.0xscale
Width m le—-4 w m 1.0xscale
Region on region triode
_M 1 m 1
Mult 1 mult 1
Mult 1 area 1
Parameters not in Spectre Model
Model
Temp T °C 25
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Ab m 2 le—-12
Ls m le-4

Lg m le—4
Mode nonlinear

Parameters not in ADS Model

mult 1

T Temp = trise + temp ("temp" is an ADS global variable)

Comments:

e The Netlist Translator looks up the model statement referenced by the model name on the instance line to
determine which ADS MOSFET device to place. For more information on MOSFET Models, refer to MOSFET
Models.

o If trise is provided, Temp = trise + temp ( temp is an ADS global variable).

Mutual Inductors

The Spectre mutual_inductor device is translated as an ADS mutual inductor.

Example Spectre Command Line:

I1 (1 0) inductor
2 (2 0) inductor
m 1 rmutual _i nductor coupling=1 indl=l1 ind2=l2

Spectre Netlist Syntax:

name mutual_inductor [param= value ]*
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ADS Netlist Syntax:

Mutual: kid K= value Inductor1="lid1 " Inductor2="1id2 "

ADS Schematic Symbol:

MUT T ND
N \

L2
Mutual L'I\% .
K1 O\/?“
Inductor1="L1" M

Inductor2="2" 3 4

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Mutual Inductors Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default
K coupling 0.0
Inductorl ind1
Inductor2 ind2
Parameters not in Spectre Model
M H
Comments:

e The ADS Schematic symbol for an individual inductor uses a slash on the wire near pin 1 as opposed to the
standard dot used in Spectre.
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e ADS Schematic Symbol: Note that the MUTIND on the left is the symbol placed when the K is read. The example
on the right is an illustration of the referenced inductors.

e ADS allows a coefficient of coupling between -1 and 1.

MXXXXXXX

Semiconductor MOSFET Device: This device is translated as either a nonlinear N-type or a nonlinear P-type MOSFET
device.

Example SPICE Command Line:

nm 1 2 3 4 Mwdel L=10U W5U AD=100P AS=100P PD=40U NRD=1 nrs=1

SPICE dialect and netlist syntax:

Spice2/3:

midndngnsnbmname[I=1][w=w][ad=ad ][ as=as]
+ [pd=pd] [ps=ps] [nrd=nrd] [nrs=nrs] [off]
+ [ic=vds, vgs, vbs] [temp=temp]

PSpice:

midndngnsnbmname[I=1][w=w][ad=ad ][ as=as]
+ [pd=pd ] [ps=ps] [nrd=nrd] [nrs=nrs] [nrg=nrg]
+ [nrb=nrb] [m=mult]

HSpice:

midndngnsnbmname [[I=]1][[w=]lw][ad=ad ][ as= as ]
+ [pd=pd] [ps=ps] [nrd=nrd] [nrs=nrs] [*off_]

+ [rdc=rdc] [rsc=rsc] [ic=vds, vgs, vbs]

+ [m=mult] [dtemp=dtemp] [geo=geo] [ngsmod=ngsmod]
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ADS Netlist Syntax:
mname :mid nd ngns nb [ Length=1] [ Width=w ][ Ad=ad ][ As=as ][ Pd= pd ] [ Ps= ps ]
ADS Schematic Symbol:

1 1

] -

i >

5 &)

MOSFET _MKMOS MOSFET _PMOS

P

Instance Parameters:

mid = MOSFET element name

mname = Model hame

nd = Drain node

ng = Gate node

ns = Source node

nb = Bulk (substrate) node

[, w = Channel length and width in meters.

ad, as = Area of the drain and source diffusions, in square meters.

pd, ps = Perimeters of the drain and source junctions, in meters.

nrd, nrs = Designate the equivalent number of squares of the drain and source diffusions; these values multiply
the sheet resistance (RSH) specified on the .MODEL control line for an accurate representation of the parasitic
series drain and source resistance of each transistor.

off = Indicates an initial condition on the device for ac analysis.

Translates to Region=0.

temp = The temperature at which this device is to operate.

dtemp = Element and circuit temperature difference. Default=0.0

mult = Multiplier used to simulate multiple parallel devices.

geo = Source/drain sharing selector

ngsmod = Non-quasi static model selector

Comments:
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The Netlist Translator looks up the model statement referenced by the model hame on the instance line to determine
which ADS MOSFET device to place. For more information on MOSFET Models, refer to [MOSFET Models].

OXXXXXXX

Lossy Transmission Lines: This device and model pair is translated as an ideal physical transmission line.

Example SPICE Command Line:

ol 1 0 3 0 Omodel
.model Omodel LTRA L=9.19e-9 C=3.65e-12 LEN=1 R=0 G=0

SPICE dialect and netlist syntax:

Spice3:

0id n1 n2 n3 n4 mname

PSpice:

Does not exist

HSpice:

Does not exist

ADS Netlist Syntax:

TL:o id Z= sqrt(l/c) L= len V= 1/(cO*sqrt(I*c)) R=rG=gF=0

ADS Schematic Symbol:

130



Advanced Design System 2008

Instance Parameters:

oid = TL element name
mname = Model name
nl, n2 = Nodes at port 1
n3, n4 = Nodes at port 2

Comments:

Parameters are read from the LTRA model statement, but no corresponding model is created in ADS. If no model is
found, these defaults values are used:

Z=500hm L=1 V=1 R=0 G=0

For the schematic version, the TL component is not supported so the TLIN4 is used. TLIN4 does not support the R and
G parameters so they are ignored. The following equations are used for TLIN4:

Z=sqrt(l/c) F=1 E=len/sqrt(I*c)*360

c0 = speed of light in free space. This is an ADS mathematical constant.

Polynomial Current-Controlled Current Source (pcccs)

The Spectre pcccs device is translated as an ADS Symbolically-Defined Device (SDD). Only the single input pcccs
device is supported by the Spectre netlist translator.
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Example Spectre Command Line:

evc_pcccs (1 2) pcces gain=0.9 m=3 coeffs=[0 0 O O oppdvcr] probe=v002

Spectre Netlist Syntax:

name p n pcccs [param= value ]*

ADS PCCCS (SDD):

SDD: evc_pcccs _node2 nodel 1[1,0]=-1*eval poly(list(0,0,0,QO0,oppdvcr), _c1,0) M3 ( 1]="v002"

 Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order

of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

Polynomial Current-Controlled Voltage Source (pccvs)

The Spectre pccvs device is translated as an ADS Symbolically-Defined Device (SDD). Only the single input pccvs
device is supported by the Spectre netlist translator.

Example Spectre Command Line:

evc_pccvs (1 2 ) pccvs gain=0.9 nr3 coeffs=[0 0 O O oppdvcr] probe=v002

Spectre Netlist Syntax:

name p n pccvs [param= value ]*
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ADS PCCVS (SDD):

SDD: evc_pccvs _node2 _nodel 1[1, 0]=eval _poly(list(0,0,0,O0,oppdvcr), _cl,0) _M3 C1]="v002"

 Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

Polynomial Voltage-Controlled Current Source (pvccs)

The Spectre pvccs device is translated as an ADS NonlinVCCS device.

Example Spectre Command Line:

v2 (netl 0 net2 0) pvccs coeffs=[0 -2e-3 -10e-3] gain=2 ml

Spectre Netlist Syntax:

name sink arc psl nsl ... pvccs coeffs=[ ... ] [param= value ]*

ADS Netlist Syntax:

VCCS_Z: name nodel node2 node3 node4 [param= value ]*

 Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.
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ADS Schematic Symbol:

J—+ -
¥
v

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Non-Linear VCCS Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Coeff=[...\]] coeffs=[...\]]

Parameters not in ADS Model

gain 1

m 1

Polynomial Voltage-Controlled Voltage Source (pvcvs)

The Spectre pvcvs device is translated as an ADS NonlinVCVS device.

Example Spectre Command Line:

vl (p 0 cl1 0) pvcvs coeffs=[0 0 0 0.1 1 1] gain=1

Spectre Netlist Syntax:
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name p n psl nsl ... pvcvs coeffs=[ ... ] [param= value ]*

ADS Netlist Syntax:

VCVS_Z: name nodel node2 node3 node4 [param= value ]*

© Note

The netlist syntax for ADS is valid only when using the backward-compatibility option (-bc option). The order
of nodes is reversed because Spectre components list the output node pair first, followed by the input node
pairs.

ADS Schematic Symbol:

-1_ =
+ +
.g_"' - 4

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation.

Non-Linear VCVS Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default

Coeff=[...\1] coeffs=[...\]]

Parameters not in ADS Model

gain 1

m 1

135


http://edocs.soco.agilent.com/display/ads2008/Translating+a+Device#TranslatingaDevice-1108455
http:/
http:/

Advanced Design System 2008

QXXXXXXX

Semiconductor BJT Device. This device is translated as one of the following:

a nonlinear NPN or PNP BJT device
a nonlinear NPN or PNP BJT device with substrate
a NPN or PNP VBIC (Vertical Bipolar Inter-Company) device

For information on the BJT model, refer to [BJT_Model:Bipolar Transistor Model]. For information on the VBIC model,
refer to [VBIC_Model:VBIC Model].

 Note

For HSpice, if the referenced model has Level=4, the appropriate VBIC device is placed.

Example SPICE Command Line:

ql 1 2 3 Qmdel 2 OFF 1C=0.6, 5.0}}
g2 1 2 3 4 Qwdel 2 1.0

SPICE dialect and netlist syntax:

Spice2/3:

qgid nc nb ne [ns] mname[ area ] [OFF] [ IC= vbe, vce ] [ TEMP=temp ]

PSpice:

qgid nc nb ne [ ns ] mnamel[area]

HSpice:

qgid nc nb ne [ ns ] mname [[AREA=] area ] [ AREAB= area]
+ [AREAC=area] [OFF] [[IC=vbe, vce] | [VBC=vbc [VCE=vce]]]
+ [M=mult] [DTEMP=temp]

136



Advanced Design System 2008

ADS Netlist Syntax:

BJT[4] mname: qgid nc nb ne [ns] [Area=area] [Temp=temp+dtemp]
+ [Region=0] [_M=mult]

VBIC mname : gid nc nb ne ns [scale=area]

ADS Schematic Symbols:

rs

-

P s
~a
-

BJT_NPN BJT4_NPN VB | C_NPN

- -y _ o

z

-
-
BJT_PNP BJT4_PNP VBIC_PNP

Instance Parameters:

gid = BJT element name
mname = Model name

nc = Collector node

nb = Base node

ne = Emitter node

ns = Substrate node

area = Area factor (default=1)
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off = Indicates an initial condition on the device for dc analysis.
Translates to Region=0

mult = Multiplier used to simulate multiple parallel devices.
temp = The temperature at which this device is to operate.

Comments:

The referenced [BJT_Model:Bipolar Transistor Model] or [VBIC_Model:VBIC Model] model is read to determine which
device to use:

NPN keyword indicates BJT_NPN, BJT4_NPN or VBIC_NPN
PNP keyword indicates BJT_PNP, BJT4_PNP or VBIC_PNP

If SCALE is specified, Value=Value*scale

If dtemp is provided, Temp=temp+dtemp

Resistor Device

The Spectre resistor device is translated as an ADS resistor device. For information on the resistor model, refer to

R_Model (Resistor Model).

Example Spectre Command Line:

Without model referenced:

rl (1 2) resistor r=1.2k me2
With model referenced:

rli (1 2) resnod | =8u w=1u

Spectre Netlist Syntax:

Without model referenced:
name nl n2 resistor [param= value ]*
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name nl n2 mname [param= value ]*

ADS Netlist Syntax:

Advanced Design System 2008

R: rid n1 n2 R= value [param= value J*

ADS Schematic Symbol:

AN, —

R

Instance Parameters:

For information on parameter format, refer to Using Parameter Mapping Tables to Understand a Translation

Resistor Parameter Mapping

ADS Name Unit Default Spectre Name Unit Default
R ohms 50 r ihms
TC1 1/°C 0.0 tcl 1/°C 0.0
TC2 1/°C 2 0.0 tc2 1/°C 2 0.0
Noise yes isnoisy yes
Length m | m
Width m w m
_M 1 m 1
Parameters not in Spectre Model
Temp T °C 25
Tnom °C 25
wPmax w infinity
wlImax A infinity
Model
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Secured

Parameters not in ADS Model

trise °C 0.0
resform yes
scale 1

t Temp = trise + temp ("temp" is an ADS global variable)

Comments:

The value of R may be positive or negative but not zero in the netlist.

The value of R cannot be an expression that changes during the simulation.
If SCALE is specified, Value = Value * scale .

If trise is provided, Temp = trise + temp ( temp is an ADS global variable).

RXXXXXXX

Resistor: This device is translated as a resistor device. For information on the resistor model, refer to
[R_Model:Resistor Model].

Example SPICE Command Line:

ri 12 1k

SPICE dialect and netlist syntax:

Spice2/3:

rid n1 n2 [value] [mname] [I=Il ] [w=w ] [ temp=temp ]

PSpice:

rid n1 n2 [ mname ] value [ tc= tcl [, tc2 ]]
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HSpice:

rid n1 n2 [mname] [r=]value [[tc1=]tcl [[tc2=]tc2]]
+ [scale=s] [m=mult] [ac=ac] [dtemp=dtemp] [I=I] [w=w] [c=c]

ADS Netlist Syntax:
R:rid n1 n2 R=value [TCl=tcl] [TC2=tc2 ] [_M=mult]

ADS Schematic Symbol:

b AAA,

R

Instance Parameters:

rid = Resistor element name

mname = Model name. Use this name in elements to reference the model.

nl, n2 = Element nodes

value = Resistance value (in ohms). Reff=R*SCALE/M.

tcl = First order temperature coefficient for resistor.

tc2 = Second order temperature coefficient for resistor.

scale = Element scale factor for resistance and capacitance. Default=1.0.

mult = Multiplier that simulates parallel resistors. For example, to represent two *parallel instances of a resistor,
set M=2 to multiply the number of resistors by 2. Default=1.0.

dtemp = Temperature difference between the element and the circuit. Default=0.0
| = Resistor length. Default=0.0, if L is not specified in the model.

w = Resistor width. Default=0.0, if W is not specified in the model.

SHRINK is a model parameter.

Wscaled=W*SHRINK*SCALE(option)

dw = Width narrowing due to etching in specified units.

dl = Length narrowing due to etching in specified units.

Comments:

If SCALE is specified, Value=Value*scale.
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In the netlist, as in ADS, the value of R may be positive or negative but not zero.

HSpice:
If the value of R is an expression which is a function of node voltages or independent variables, then the component is
a dependent resistor. In ADS, the component is represented by a Symbolically Defined Device (SDD).

If one of the SDD parameters uses a variable containing node voltages, the translator needs to look up the node
voltages on the resultant SDD to convert them to the correct ADS syntax and update the variable expression. For
instance, the node voltage described as v(nhodeX) in HSpice must be converted to _v1, if the first pair of nodes on the
SDD is (nodel, 0).

For translation purposes of this special case, the SDD and the variable used by it are expected to be defined in the
same subcircuit, with the variable being used by only one SDD. If the variable were defined globally or used by
different SDDs, the node voltage variables (_v1, etc.) might not match up correctly. For example, in the case
described above one SDD might have (nodeX,0) as the first pair of nodes (_v1), while another SDD might have
(nodeX,0) as the 2nd pair of nodes (_v2). The translator would not be able to replace v(nodeX) in the variable
expression to define both SDDs correctly at the same time.

If this SDD is not found in the same subcircuit as the variable expression, a warning message will be written to the log
file nettrans.log. Also, the expression will not be converted automatically, and it will have to be fixed manually before
simulation is attempted.

If dtemp is provided, Temp=temp+dtemp

The Netlist Translator fails to recognize the resistor model in the following syntax:

rli 1 2 rmodel

The translator assumes that it is a variable name for the resistor value. To correct your imported schematic, manually
move the model name to the parameter Model. To correct the ADS Netlist, use the following netlist syntax:

rmodel:rl 1 2 [param=value]*

Subcircuit Reference

This device is translated as an instance of a subnetwork. For information on the parametric subnetwork command,
refer to subckt, ends.
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Example Spectre Netlist:

inline subckt indline \(in out gnd\)

par aneters

\ + hoverw=pmnsxt/ pw}}

\+ fhwl =1/\ (\ (1/ hoverw )\ +2. 42-\ (0. 44\ *hover w )\ +1- hover W )\ *\ *6\)
\+ fhwg = di1==\(2\*pi\ (\)\)\*1 og\ (\ (8\*hoverwh )\ +\ (0. 25/ hoverw )\)
\'+ fhw = \ (hoverw==1\)\*f hwl \ +\ (hover w>=1\)\ *f hwg

rsxout subout gnd resistor r=prsx\*2 tcl=trsub trise=dtenp

ends indline

ADS Netlist Syntax:

SUBNAME:x id [n1*] [ name =value*] [ M= _mult ]

xid = Subnetwork element name

nil* = Node names

subname = Specifies the name of the
subnetwork.

name = Parameter name or subcircuit
definition.

value = A parameter value passed to the
subnetwork.

mult = Multiplier used to simulate multiple

parallel devices.

Comments:

The ADS netlist format does not support subcircuits containing parameters that reference each other. In ADS 2005A,
these are supported in Spectre syntax. Thus wrappers will be added as shown in Example Spectre Subcircuit with
Referenced Parameter Value. With the -bc option (i.e. backward compatibility mode), any Spectre subcircuit equations
that reference each other are moved from the subcircuit parameter list and are listed as subcircuit equations. In
addition, a warning message will be generated as follows:

The subcircuit "ckt_nane" contained paraneters that reference each other. In order to maintain
conpatibility with ADS, these have been noved off the subcircuit paraneters list and are
treated as circuit equations. Conponent instances that reference this subcircuit will not be
able to directly override these val ues.
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Device Tables for SPICE

This section provides individual device translation information for each specific device supported by the Netlist
Translator. Supported devices are listed here.
BXXXXXXX

CXXXXXXX
DXXXXXXX
EXXXXXXX
EXXXXXXX

GXXXXXXX
HXXXXXXX
IXXXXXXX

IXXXXXXX

KXXXXXXX
LXXXXXXX

MXXXXXXX
OXXXXXXX
QXXXXXXX
RXXXXXXX
TXXXXXXX

UXXXXXXX
VXXXXXXX

XXXXXXXX
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ZXXXXXXX

For information on unsupported devices, refer to Unsupported Devices.

TXXXXXXX

Transmission Lines (Lossless): This device is translated as an ideal 4-terminal transmission line.

Example SPICE Command Line:

tl1 102 0 z0=50 TD=10ns | C=1nv, 1me, .2nv, .6MA
t2 10 2 0 z0=50 F=1.7GHz NL=0.3
t3 102 0 z0=50 F=1.2GHz

SPICE dialect and netlist syntax:

Spice2/3:

tid n1 n2 n3 n4 Z0=zval[[TD=tval ] | [F=fval[ NL=nval]]]
+ [IC=v1, i1, v2, i2]

PSpice:

tid n1 n2 n3 n4 [ model ] Z0=zval[[ TD=tval ] | [F=fval[ NL= nval ]]]
+ [IC=v1, i1, v2, i2]

HSpice:

tid n1 n2 n3 n4 [ model ] Z0=zval [[ TD=tval [L=11]] |
+ [F=fval [NL=nval]]] [IC=V1, i1, v2, i2]

ADS Netlist Syntax:

If TD is given:
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TLIN4: tid n1 n2 n3 n4 Z=zval F=1 E=tval*360

If F is given:

TLIN4: tid n1 n2 n3 n4 Z=zval F=fval E=nval*360

ADS Schematic Symbol:

-

o -

TLINS

Instance Parameters:

tid = TL element name

nl, n2 = Nodes at port 1

n3, n4 = Nodes at port 2

zval = Characteristic impedance

tval, fval = Length of line may be expressed in either of two forms. The transmission delay (TD) may be
specified directly or frequency (F) may be given together with NL.

nval = Normalized electrical length of the transmission line with respect to the wavelength in the line frequency.
If F is specified but NL is omitted, 0.25 is assumed.

vl, i1, v2, i2 = The voltage and current at each of the transmission line ports. Ignored translation.

Comments:

PSpice:

Optional lossy format: n1 n2 n3 n4 LEN=len R=r L=| G=g C=c

R and G are not supported for the schematic version. For the netlist version, the alternate component TL will be
used so these values are handled properly.
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ADS Netlist Syntax:
TL:tid n1 n2 n3 n4 Z=sqrt(l/c) L=len V=1/(cO*sqrt(I*c)) R=r G=g F=0

If a model reference is used, the model is read and parameters are used on the device as needed. No model is
placed and unused parameters are discarded.

HSpice:

Optional syntax: tid n1 n2 n3 n4 Z=zval I=len
translates as: TLIN4:tid n1 n2 n3 n4 z=zval F=1 E=(len/c0)*360

c0 = speed of light in free space. This is an ADS mathematical constant.

UXXXXXXX

Uniform Distributed RC Lines (Lossy): This device is translated as two ideal transformers and one ideal distributed RC
line.

Example SPICE Command Line:

ul 1 2 3 URCnodel L=50u N=6
. nodel URCnodel URC RPERL=r per| CPERL=cper |

SPICE dialect and netlist syntax:

Spice2/3:

uid nin nout nref mname L=len N=lumps

PSpice:

Does not exist
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HSpice:

Not supported

ADS Netlist Syntax:

RCLIN:uid nin nout L=len R=rperl C=cperl
OR If node 3 is not ground:

tf:tf1 nin nref net1 0
RCLIN:uid netl net2 L=len R=rperl C=cperl
tf:tf2 net2 0 nout nref

ADS Schematic Symbol:

RCLIN

A

TF
TF1

Instance Parameters:

uid = Element name

nin, nout = The two element nodes the RC line connects

nref = Node to which the capacitance is connected.

netl, net2 = Nodes inserted to connect RCLIN to transformers.

L = Length of the RC line in meters.

lumps = The number of lumped segments to use in modeling the RC line.
rperl = Resistance per unit length in Ohm/m (default=1000).

cperl = Capacitance per unit length in F/m (default=1.0e-15).
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Comments:

N is ignored in translation.

Model parameters are read off the URC model, but no model is placed. Unused parameters are discarded. If the
referenced model is not found, the default values specified above are used.

If node 3 is not ground, the transformers are added to float the RCLIN.

VXXX XXXX

Independent Voltage Source: This device is translated as either a V_Source (ADS Netlist) or a VtUserDef (ADS
Schematic).

Example SPICE Command Line:

vi1l2DC6
v2 2 36 AC1 90

v3 3 0 PULSE(-1 1 2NS 2NS 2NS 50NS 100NS)

v4 3 0 SIN(O 1 100MEG 1NS 1E10)

v5 3 0 EXP(-4 -1 2NS 30NS 60NS 40NS)

v6 7 5 PW(0 -7 10NS -7 11NS -3 17NS -3 18NS -7 50NS - 7)
v7 12 0 SFFMO0 1M 20K 5 1K)

Spice2/3:

vid n+ n- [[ dc ]dcval] [ac [mag [phase]]] [tranfunc]

PSpice:

vid n+ n- [[dc] dcval] [ac [mag [phase ]]] [tranfunc]

HSpice:

vid n+ n- [[dc] dcval ] [ ac [mag [ phase ]]] [tranfunc]
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ADS Netlist Syntax:

V_Source:v id n+ n- Vdc=dcval Vac=polar(mag,phase) V_Tran=tranfunc

ADS Schematic Symbol:

3 VtUserDef

Instance Parameters:

vid = Element name. Note that leading bold letter is included in the device name.

n+ = Positive node

n- = Negative node

dcval = The dc voltage

mag, phase = The magnitude and phase of the ac voltage.

tranfunc = Transient Source Functions. There are several built in ADS functions that mimic the SPICE transient source
functions listed below.

SPICE Advanced Design System

EXP() exp_pulse(time, low, high, tdelayl, taul, tdelay2, tau2)
PULSE()pulse(time, low, high, delay, rise, fall, width, period)
PWL()pwl(time, t1, x1,..., tn, xn)

SFFM()sffm(time, offset, amplitude, carrier_freq, mod_index, signal_freq)
SIN()damped_sin(time, offset, amplitude, freq, delay, damping)

HSpice

PU()pulse(time, low, high, delay, rise, fall, width, period)
AM()Not translated.
PL()Not translated.
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Comments:

HSpice:

HSpice multiplier on Voltage sources - This is implemented by making an expression out of the given voltage
value. Example:

HSpice: vl n1 n2 500uv m=10
ADS: egn0=(500uv)*(10)
V_Source: vl n1 n2 Vdc=500uv*10

Unsupported HSpice transient functions - AM, PL

Unsupported HSpice syntax extensions -

Data driven PWL source
Repeat and Time Delay specifications in PWL transient function (R=repeat, TD=delay)

PSpice:

Unsupported PSpice syntax extensions

STIMULUS

corner points, TIME_SCALE_FACTOR, VALUE_SCALE_FACTOR

XXXXX XXX

Subcircuit Reference: This device is translated as an instance of a subnetwork. For information on the parametric
subnetwork command, refer to ".SUBCKT"].

Example SPICE Command Line:

x1 2 4 17 31 opanp
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SPICE dialect and netlist syntax:

Spice2/3:

xid [n1*] subname

PSpice:

xid [n1*] subname[ OPTIONAL.: interface node = default value ]
+ [PARAMS: name=value*] [TEXT: name=textvalue]

HSpice:

xid [n1*] subname [ name=value * ] [m=mult]

ADS Netlist Syntax:

SUBNAME:xid [n1*] [name=value*] [ _M=mult]

Instance Parameters:

xid = Subnetwork element name

nl* = Node names

subname = Specifies the name of the subnetwork.

name = Parameter name or subcircuit definition.

value = A parameter value passed to the subnetwork.

mult = Multiplier used to simulate multiple parallel devices.

Comments:

PSpice:

OPTIONAL and TEXT parameters are ignored by the translator.

152



Advanced Design System 2008

ZXXXXXXX

Semiconductor MESFET Device: This device is translated as a nonlinear N-type GaAsFET device. For information on the
GaAsFET model, refer to the [Statz_Model:Statz \(Raytheon\) GaAsFET Model].

Example SPICE Command Line:

z1 1 2 3 Znodel 2 OFF 1 C=0.6, 5.0

SPICE dialect and netlist syntax:

Spice2/3:

zid nd ng ns mname [ area ] [ OFF ] [ IC=vds, vgs]

PSpice:

Does not exist.

HSpice:

Does not exist.

ADS Netlist Syntax:

mname : zid nd ng nd Area=area Region=0

ADS Schematic Symbol:
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T
R

GaAsFET

<

Instance Parameters:

zid = GaAsFET element name

mname = Model name

nd = Drain node

ng = Gate node

ns = Source node

area = Area factor

OFF = Indicates an initial condition on the device for dc analysis. Translates to Region=0.

ic=vds, vgs = The initial condition specification intended for use with the UIC option on the .TRAN control line. Not
translated.

Unsupported Devices

The following devices are not supported:

AXXXXXXX
NXXXXXXX
Pxxxxxxx
SXXXXXXX
WXXXXXXX
Y XXXXXXX

The following additional information provides a suggested action for your translation, each of which requires using a
Symbolically Defined Device (SDD). For information on SDD's, refer to Using a Symbolically Defined Device.

Non-Linear Dependent Source (SPICE 3 only):
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Bxxxxxxx N+ N- | =expression V=expression

Suggested Action

Insert an SDD to replace the unmapped element. Assign the appropriate wire labels to the SDD so you can

maintain connectivity of the circuit. Insert the equation I=expression or V=expression into the correct current or
voltage port definition.

Voltage Controlled Switch (SPICE 3 only):

Sxxxxxxx N+ N- NC+ NC- mmane [ON] [ OFF]

Suggested Action

Insert an SDD to replace the unmapped element. Assign the appropriate wire labels to the SDD so you can
maintain connectivity of the circuit.

Current Controlled Switch (SPICE 3 only):

WXxxxxx N+ N- VNAM mane [ ON] [ OFF]

Suggested Action

Insert an SDD to replace the unmapped element. Assign the appropriate wire labels to the SDD so you can
maintain connectivity of the circuit.

Using a Symbolically Defined Device

The symbolically-defined device (SDD) enables you to create equation based, user-defined, nonlinear components in
ADS. The SDD is a multi-port device which is defined by specifying algebraic relationships that relate the port
voltages, currents, and their derivatives, plus currents from certain other devices.

Controlled sources from SPICE are modeled in ADS using the symbolically-defined device. The SDD allows a voltage or
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current source to be constructed whose output can be described as an arbitrary combination of a number of
controlling voltages or currents.

e voltage controlled voltage source
SDD: nane nclp ncln nc2p nc2n outp outn \
IN[2,0\]=0 I1\[2,0\]=0 F\[3,0\]=_v3-\(output_voltage\(_vi, _v2\)\)

g voltage controlled current source
SDD: name nclp ncln nc2p nc2n outp outn \
IN[1,0\]=0 I\[2,0\]=0 I\[3,0\]=\(output _current\(_vl, _v2\)\)

h current controlled vol tage source
SDD: nane outp outn Q [1\]=currentl Q\[2\]=current2 \
F\[1,0\]=_v1-\(output_voltage\(_cl, _c2\)\)

f current controlled current source
SDD: nane outp outn Q\[1\]=currentl Q[2\]=current2 \
IN[1,0\] =\ (output _current\(_cl, _c2\)\)

The voltage controlled sources have 2(n+1) nodes, where n is the number of controls. The controlling voltage nodes
are listed first in pairs (nclp ncln) at ports 1 through n, then the output node pair (outp outn) at port n+1. The
controlling voltages have symbolic names like _v1. Each controlling voltage must have a current equation written for it
(I[1,0]=0) so that no current flows between the controlling nodes through the SDD.

The current controlled sources have only 2 output nodes at port 1, while the name of the sources used to measure the
controlling currents are specified using C[1]="ivs1". The controlling currents have symbolic names like _c1.

Current sources are written as a simple expression for the current at the output port. This expression is in SI units and
is written in terms of the controls:

I[3,0]=_v1*1le-3+_v2*2e-3

A voltage source must have an implicit expression for the voltage at the output port such that F[3,0]=_v3-vout, where
vout is the desired output voltage:

F[3,0]=_v3-(_v1*24+_v1*v2)

Controlled sources in SPICE may be linear or nonlinear and there may be one or more controlling voltages or currents.
The general form of a controlled source is:

?id nodel node2 [poly(dim)] [sourcename | nodecp nodecn]*
+ value [value]*
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The source has two nodes with the same polarity convention as the dependent sources. The method of specifying
controls depends on whether the source is voltage controlled or current controlled. Current-controlled sources give the
name of a source through which the current is measured; voltage-controlled sources provide two nodes with which to
measure a differential voltage. The simple linear form for all four types:

eid n+ n- nc+ nc- value ; vout = value * vcon
fid n+ n- vname value ; iout = value * icon
gid n+ n- nc+ nc- value ; iout = value * vcon
hid n+ n- vname value ; vout = value * icon

A nonlinear source may be created whose output is a polynomial function of its control:

eid n+ n- nc+ nc- vO vl v2 v3 ... [ic=]

The polynomial is interpreted as:

v out =vO0+v1* v con +v2* v 2 con +...

unless only a single value is given, in which case it reverts to a linear behavior:

v out =v0* v con

SPICE allows controlled sources with more than one control. When there is more than one control. the poly keyword
must be used to identify the number of controls. The dimension refers to the number of controlling sources, not the
order of the polynomial.

eid n+ n- poly(dim) [ nc+ nc- ]* values ... [ic=]

Coefficients for a polynomial of dimension two are interpreted as:
v out =v0

+v1*vconl+v2*vcon2

+v3*v2conl+v4*v conl*vcon2+v5*v2con2
+v6*Vv_3conl+v7*v2conl*vcon2+v8*vconl*v2con2+v9*v3con2
+...

Coefficients for a polynomial of dimension three are interpreted as:
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vout=v0

+v1*vconl+v2*vcon2+v3*vcon3
+v4*yv2conl+v5*vconl*vcon2+v6*vconl*vcon3+v7*v2con2+v8*vcon2*vcon3+v9*v2con3
+v10*v3conl+v11*v2conl*vcon2+v12*v2conl*vcon3+v13*vconl*v2con2+v14*vconl*vcon2*vcon3
+v15*vconl*v2con3+v16*v3con2+v17*v2con2*vcon3+v18*vcon2*v2con3+v19*v3con3*
+v20*v4conl+...

The SPICE syntax provides no simple way to specify just a couple of the individual terms. If only the v14 term is
needed, v0 through v13 must still be specified with zeros.

Initial conditions here are used to provide a guess at what the controlling values will be so the output of the
dependent source can be evaluated; the initial values do not actually influence the controlling values. Enough initial
conditions must be provided to match the dimensionality of the source.

Several translation examples for SPICE are presented below.

Examplel

SPICE Netlist:

* |inear vcvs
e01 vout 0 vclp vcln 0.05

ADS Netlist:

SDD: e01 vclp veln vout O 1[1,0]=0 F[2,0]=_v2-(0.05*_v1)

Example 2

SPICE Netlist:

* |inear cccs
f0l1 vout 0 vnane 0.05

ADS Netlist:
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SDD: f01 vout O C 1] =vname I[1,0]=0.05* c1

Example 3

SPICE Netlist:

* |inear vccs
g0l vout 0 vclp vcln 0.05

ADS Netlist:

SDD: g01 vclp veln vout O I1[1,0]=0 I[2,0]=0.05*_v1l

Example 4

SPICE Netlist:

* |inear ccvs
h0l1 vout 0 vnane 0.05

ADS Netlist:

SDD: h01 vout 0 C[1]=vname I[1,0]=0 F[1,0]=_vi-(0.05* cl)

Example 5

SPICE Netlist:

* one input polynom al vcvs
* vout =0. 5+0. 1*vc1+0. 01*vc1”72+0. 001*vc1n3
e02 vout 0 nclp ncln 0.5 0.1 0.01 0.001
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ADS Netlist:

SDD: e02 nclp ncln vout O I[1,0]=0 \
F[ 2, 0] =_v2-(0.5+0. 1* _v1+0.01* v172+0.001* v1~3)

Example 6

SPICE Netlist:

* two input polynom al cccs
* jout=0.0+0. 2*i 1+0. 3*i 2+0. 01*i 172+0. 02*i 1*i 2+0. 03*i 22
f02 vout 0 poly(2) vnanel vnane2 0.0 0.2 0.3 0.01 0.02 0.03

ADS Netlist:

SDD: f 02 vout 0 ([ 1] =vhanmel ( 2] =vnane2 \
I[1,0]=0.0+0. 2* c1+0.3* c2+0.01* c172+0. 02* c1* c2+0. 03*_c2/2

Example 7

SPICE Netlist:

* three input polynom al vccs

* jout=0.1*vcl+0. 2*vc2+0. 3*vc3

g02 vout 0 poly(3) vclp vcln ve2p ve2n ve3p ve3n
+00.10.20.3

ADS Netlist:

SDD: g02 vclp veln ve2p ve2n ve3p ve3n vout 0\
I[1,0]=0 1[2,0]=0 I[3,0]=0\
F[ 4, 0] =_v4- (0+0. 1* _v1+0. 2* _v2+0. 3* _v3)

For more information, refer to Chapter 5, "Custom Modeling with Symbolic Devices", in the User Defined Models
manual.
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Translating a Model

This chapter provides model translation information for each of the models supported by the Netlist Translator. The
following are the supported ADS models:

R_Model:Resistor Model
L_Model:Inductor Model

C Model:Capacitor Model
Diode_Model: PN-Junction Diode Model
BJT_Model:Bipolar Transistor Model

HICUM_Model:HICUM Bipolar Transistor Model

Mextram Model:Mextram Model

Mextram 504 Model:Mextram 504 Model

VBIC Model:VBIC Model

STBJT Model: STBIT Model

LEVEL1 Model:LEVEL 1 MOSFET Model

LEVEL2 Model:LEVEL 2 MOSFET Model

LEVEL3 Model:LEVEL 3 MOSFET Model

BSIM1 Model:BSIM1 MOSFET Model

BSIM2 Model:BSIM2 MOSFET Model

BSIM3 Model:BSIM3 MOSFET Model

BSIM4 Model:BSIM4 MOSFET Model

BSIM3SOI Model: BSIM3SOI Model
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MOS_ Model9 Process: Philips MOS Model 9 (Process Based)
Advanced Curtice2 Model:Advanced Curtice-Quadratic GaAsFET
Statz Model:Statz (Raytheon) GaAsFET Model

TOM_Model:Triquint Scalable Nonlinear GaAsFET Model

JFET Model:Junction Field Effect Transistor Model

Using Parameter Mapping Tables to Understand a Translation

Model parameter information is organized in tables with the ADS parameter, default value, and unit in the three
left-hand columns of the table. The Berkeley SPICE 2 & 3, PSpice, HSpice, and Spectre parameter translation
information is described in the right-hand columns. In some cases where ADS does not translate a particular dialect,
the column for that dialect has been removed.

The parameters that are not translated are not always included in the tables. For detailed parameter information for a
specific SPICE or Spectre model, refer to the appropriate vendor's documentation for that specific model.

For each SPICE or Spectre parameter in the Model Parameter table, the following conventions apply:

¢ An "x" indicates that the SPICE or Spectre default value and units are the same as ADS. Any deviations are listed
explicitly.

e A "-"indicates the parameter does not exist in that particular dialect.

e Extra parameter names listed are aliases and are converted to the proper name in ADS by the translator.

ADS Model Parameters that are not listed are not supported by any SPICE or Spectre dialects and will use standard
ADS defaults. For an alphabetical listing of ADS supported models and a detailed description of their parameters and
default values, refer to the Advanced Design System Circuit Components manual.

R, C, L and Diode Models for Spectre

This section contains detailed parameter information for the Resistor (R), Capacitor (C), Inductor (I), and Diode
models:

¢ [R_Model:Resistor Model]
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e [L_Model:Inductor Model]
e [C_Model:Capacitor Model]

e [Diode_Model: PN-Junction Diode Model]

User Defined Models and Parameter Mapping Rules

User Defined Models
Spectre functions are single line expressions, all arguments are real and can be defined at the top level only. Only
functions of the type "real" are supported. The following example shows how Spectre Functions are translated into

their ADS equivalent.

Spectre Netlist syntax:

real myfunc \( \[real argl, ... real argn\] \{
return <expr of argl..argn>

\}

ADS Netlist syntax:

nyfunc\ (argl, ... argn\)=<expr of argl..argn>
 Note
This document refers to source dialect to indicate a generic modelling dialect. The rules and examples relate to

any modelling dialect, including Spectre.

The Spectre mapping rules reside in a file called spectre.rul . The file can be edited or copied for your customizing
needs. Customizing can consist of modifying the mapping rules for existing model translations or adding new models

to the translation portfolio.

OpenTranslator Mapping Rules

Type
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This refers to the type of entry in the map file. This is necessary because some spice dialects can have the same
InputName for components and models. This distinguishes those cases from each other.

The following are possible entries:

e element

Indicates this entry is a component type.
e model

Indicates this entry is a model type.

Input Name

This is the identifier that source dialect uses to indicate the type of component.

Output Name

This is the reference used to indicate the type of ADS component. This is a comma delimited list to support the
mapping of many names. This is useful, for example, if you need to map to a different name depending upon if you
are generating IFF versus Netlist output.

Pin Mapping

The pin mapping is straight forward. Each pin has a comma delimiter and groups have a semi-colon delimiter. The
following is an example:

[1,2;2,1]

Here source dialect pin #1 maps to ADS pin #2 and source dialect pin #2 maps to ADS pin #1

Parameter Mapping

Parameters are mapped in the order of source dialect parameter, ADS parameter, then source dialect default value. If
the source dialect and ADS names are the same, only list the source dialect name. If the source dialect and ADS
default values are the same, do not list the source dialect default value. The following is an example:

lc, C 0.0

Here "c" is the source dialect parameter name, "C" is the ADS parameter name (case sensitive), and the default is set
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to 0.0.

Multiple Parameters Mapping to a Single ADS Parameter

If there are multiple parameters that map to the same ADS parameter name, they will be separated with a tilde. The
following is the general rule:

| X[~Y ~Z],[W],[value];...|

The following is an example:

| R, 50; WWdth, Wdth, ;...

Here the source dialect parameter "R" maps to ADS parameter "R" and it will use the default value of 50. Note that
only list the source dialect hame is listed since ADS uses the same name. In the second case, either "W" or "Width"
can be the source dialect parameter and they both map to the ADS parameter "Width". Note that the default value is
not specified since source dialect and ADS use the same value.

Perl Callbacks

There are two entries for Perl callbacks. The first is the Perl file and the second is the Perl routine to be called.
The order of the callbacks are as follows:

Component name
Pin operations
Parameter name
Model operations
Last Chance

uhwnNe

The order of the callbacks is the same as the order of the map rule structure with the addition of the two callbacks,
Model operations and Last Chance.

Component name

The Component name callback will map source dialect component names to the appropriate ADS name. This is
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necessary to support either Netlist output or IFF output from the translator.

Pin operations

The Pin operations callback can handle more sophisticated pin manipulation than just straight pin mappings. For
example, some BJT devices require either three or four pins depending upon the configuration.

Parameter name

The Parameter name callback will translate the source dialect parameter names to ADS names that are listed in the
rules file.

Model operations

The Model operations callback handles cases where more model processing is needed that just a straight across
mapping.

Last Chance

The Last Chance callback is user configurable and is the last called in the sequence of callbacks.

Perl Callback Syntax

The following is the rule syntax for callbacks:

| filename, callback ; [ filename,] callback ;...

 Note

Any entry that does not have filename listed is assumed to be a callback in the last known filename.

The following is an example:

166



Advanced Design System 2008

| bsi m pl , nodel _nmappi ng; , par am nmappi ng|

Here, at the appropriate time during post processing the Perl code will call bsim.pl to source the perl file and then call

the routine model_mapping.
The next routine that will be called is param_mapping and it is assumed to be in the same file.

The following paths will be searched to locate the Perl files:

$HOME/hpeesof/links/spice/perl/ dialect
$HPEESOF_DIR/links/spice/perl/ dialect
../perl/ dialect

Where dialect could be anything you want to call it; dialect will be set from the command line argument -pl <dialect>.

 Note

The continuation character \ can be used at any time to keep the line from getting excessively long.

The comment character # can be used at the beginning of any line.

Translating Commands and Functions

This chapter provides information on translating individual commands, functions, and the binning process from
Spectre and SPICE to Advanced Design System.

Commands, Functions, and Binning for Spectre

The following table displays a list of commands and functions that are supported by the Netlist Translator.

Command / Function Description
ends End of Subcircuit
check Ignored by ADS
include Include File
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info Ignored by ADS

library Library File

parameters Parameter

subckt, ends Subcircuit

Other Functions Function Mapping in the spectrefunc.rul File

If the translator reads a command that is not recognized or supported, the translation log file will include a warning
such as:

WARNI NG Ski ppi ng unsupported statenment. ALTER, |ine 10.

alter and altergroup

The ADS simulator does not have a comparable command. Translation will terminate when this line is found.
Everything before it will be translated. Everything after it will be ignored.

check

All check statements will be ignored by the Netlist Translator.

ends

See subckt, ends.

include

This line identifies another Spectre file that needs to be read by the translator. The contents are integrated directly
into the translated design as appropriate.

Spectre Netlist Syntax:
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include file_name

ADS Netlist Syntax:

There is no ADS syntax since the referenced file is read and the contents are processed as part of the parent file.

ADS Schematic Symbol:

There is no ADS symbol since the referenced file is read and the contents are processed as part of the parent file.

Parameters:

name = Legal file name including file extension.

Comments:

The include statement is used in Spectre to insert the contents of another file. In ADS, separate include statements
are not created.

Instead, the collection of files are processed as if they were one long file. All circuits defined in an include statement
are read by the translator,

but a schematic will only be created for those that are referenced in the design hierarchy.

To force creation of all schematics for all subcircuits in an include file, import the include file separately. Note that the
top line of an include file may not be a comment line, so to read it as a stand-alone file, insert a comment line or a
blank line as line 1, if the existing line 1 has information that needs to be processed. Alternately, you may uncheck the
box in the import dialog options page to indicate that the first line is not a comment (refer to Setting the Import
Options), or use the command line argument -| (refer to Executing the Nettrans Command) to deselect the First line is
a comment option.

For tips on debugging the translation of a large set of nested include files, refer to Troubleshooting.

info

All info statements will be ignored by the Netlist Translator.
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library

This line indicates that another Spectre file is to be read by the translator. The contents are integrated directly into the
translated design as appropriate.

Spectre Netlist Syntax:

library library_name
section section_name_
<statements>

endsection [section_name]
section [another_name]
<statements>

endsection [another_name]
library library_name

ADS Netlist Syntax:

No ADS netlist syntax because the contents are just read and processed like the include file.

ADS Schematic Symbol:

No ADS Schematic Symbol because the contents are just read and processed like the include file.

Parameters:

entryname = Name of library within specified file
filename = Legal file name including extension.
dirpath = Optional path to library file. There is no space between dirpath and filename when dirpath is given.

Comments:

The library statement is used in Spectre to insert the contents of another file. In ADS, separate include statements are
not created. Instead, the collection of files are processed as if they were one long file. All circuits defined in a library
statement are read by the translator, but a schematic will only be created for those that are referenced in the design
hierarchy.
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To force creation of all schematics for all subcircuits in a library file, import the library file separately. Note that the
top line of a library file may not be a comment line, so to read it as a stand-alone file, insert a comment line or a
blank line as line 1, if the existing line 1 has information that needs to be processed. Alternately, you may uncheck the
box in the import dialog options page to indicate that the first line is not a comment (refer to Setting the Import

Options), or use the command line argument -l (refer to Executing the Nettrans Command) to deselect the First line is
a comment option.

For a description of the -models command, refer to Executing the Nettrans Command. This command can be used to
read a model file and create a separate ADS netlist file for each model.

Not supported:

The ADS translator does not automatically read nom.lib and it does not use the search path. All libraries must be
specified explicitly with a full path if the library file is not in the working directory. If the file nom.lib is needed, an
include statement should be added to the main source file to instruct the translator to read that file.

The .OPTIONS SEARCH statement is not supported by the translator. All library paths must be explicitly specified.

parameters

This line is translated as a name=value parameter.

Spectre Syntax:

parameter name=value

ADS Netlist Syntax:

name=value

ADS Schematic Symbol:

V Var
ar Vari
Eqn X=1.0

Parameters:
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name = Parameter name
value = Parameter value

subckt, ends

This line is translated as a parametric subnetwork.

& Note

The keyword inline is optional in the syntax below. If the keyword exists in the Spectre input, it will be
translated in the ADS netlist.

inline subckt subname ( nodel...nodeN )
parameters name=value
end subname

inline define subname ( nl...)
parameters name=value
end subname

ADS Schematic Symbol:

subname

x1
subname

X2

Parameters:
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subname = Subnetwork name
nl* = Node names

name = Parameter name

value = Parameter default value

ends = Spectre subcircuit definitions must end with an ends statement.

Comments:

For more information on defining subcircuit parameters, refer to Using the Netlistinclude Component.

Other Functions

Functions such as log10(x) and In(x) are mapped in the spectrefunc.rul file. Any function that requires mapping into
the equivalent ADS function is entered into this file. For more information about function mapping, see User Defined

Models and Parameter Mapping Rules.

Commands and Functions for SPICE

Command / Function
.ALIASES and .ENDALIASES
alter and altergroup
-END
-ENDL
.ENDS or .EOM
IC

INC[LUDE
.LIB, .ENDLIB

.MACRO, .ENDM

.MODEL
.NODESET
-NOISE
.OP

parameters

Description
Aliases and Endaliases
Alternate
End of Circuit
End of Library
End of Subcircuit
Initial Bias Point Condition
Include File
Library File
Macro
Model
Set the Approximate Node Voltage for the Bias Point
Noise Analysis
Bias Point

Analysis Options
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parameters Parameter

subckt, ends Subcircuit

.TEMP Temperature

.TRAN Transient Analysis

.FUNC User-defined function (PSpice only)

If the translator reads a command that is not recognized or supported, the translation log file will include a warning
such as:

WARNI NG Ski ppi ng unsupported statenment. ALTER, |ine 10.

.ALIASES and .ENDALIASES

This command block is recognized but not translated. Everything between the .ALIASES and .ENDALIASES lines is
ignored.

.ALTER

The ADS simulator does not have a comparable command. Translation will terminate when this line is found.
Everything before it will be translated. Everything after it will be ignored.

.DCVOLT

The .DCVOLT statement is processed exactly the same as a .IC statement. For more information, refer to .IC.

.END

All processing stops when a .END statement is encountered. Comments and any other information following the .END
statement are discarded.

.ENDL
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See .LIB, .ENDLIB.

.ENDS or .EOM

See subckt, ends or .MACRO, .ENDM.

IC

This line is translated as an initial condition control element. It sets the initial conditions for a transient simulation.

Example SPICE Command Line:

IC V(11)=5 V(4)=-5 V(2)=2.2

SPICE Netlist Syntax:

.ic v(node)=val[v(node)=val ]*]

ADS Netlist Syntax:

InitCond:instanceNameNodeName[1]=nodeV[1]=val
NodeName[2]=node V[2]=val

ADS Schematic Symbol:
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Init
Cond

InitCond

InitCondl

NodeMName="net] 1™ V=5 R=
NodeName="netd"” V=-3 R=
NodeName="net?" V=2.2

Parameters:

node = Node number
val = Voltage at the specified node.
instanceName = Unique component name. This is not provided by SPICE so it is automatically generated by the

translator.

Comments:

The following PSpice syntax variations are not translated:

.IC V(inPlus,inMinus)=1e-3
JIC I(L1)=2uAmp

.INC[LUDE]

This line identifies another SPICE file that needs to be read by the translator. The contents are integrated directly into
the translated design as appropriate.

Example SPICE Command Line:

.INC vars.inc
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SPICE Netlist Syntax:

.INC name

ADS Netlist Syntax:

There is no ADS syntax since the referenced file is read and the contents are processed as part of the parent file.

ADS Schematic Symbol:

There is no ADS symbol since the referenced file is read and the contents are processed as part of the parent
file.

Parameters

name = Legal file name including file extension.

Comments:

The .INC statement is used in SPICE to insert the contents of another file. In ADS, separate include statements are
not created. Instead, the collection of files are processed as if they were one long file. All circuits defined in a .INC
statement are read by the translator, but a schematic will only be created for those that are referenced in the design
hierarchy.

To force creation of all schematics for all subcircuits in an include file, import the include file separately. Note that the
top line of an include file may not be a comment line, so to read it as a stand-alone file, insert a comment line or a
blank line as line 1, if the existing line 1 has information that needs to be processed. Alternately, you may uncheck the
box in the import dialog options page to indicate that the first line is not a comment (refer to Setting the Import
Options), or use the command line argument -| (refer to Executing the Nettrans Command) to deselect the First line is
a comment option.

For tips on debugging the translation of a large set of nested include files, refer to Troubleshooting.

.LIB, .ENDLIB
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This line indicates that another SPICE file is to be read by the translator. The contents are integrated directly into the
translated design as appropriate.

Example SPICE Command Line:

PSpice: .LIB linear.lib
HSpice library call: . LIB 'filel" nps8
HSpice library definition: . LI B nps8

SPICE Dialect and Netlist Syntax

Spice2/3: Not supported

PSpice: .LIB name

HSpice library call: .LIB '<dirpath>filename' entryname
HSpice library definition: .LIB entryname

ADS Netlist Syntax:

No ADS netlist syntax because the contents are just read and processed like the include file.

ADS Schematic Symbol:

No ADS Schematic Symbol because the contents are just read and processed like the include file.

Parameters:

entryname = Name of library within specified file
filename = Legal file name including extension.
dirpath = Optional path to library file. There is no space between dirpath and filename when dirpath is given.

Comments:

The .LIB statement is used in SPICE to insert the contents of another file. In ADS, separate include statements are not
created. Instead, the collection of files are processed as if they were one long file. All circuits defined in a .LIB
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statement are read by the translator, but a schematic will only be created for those that are referenced in the design
hierarchy.

To force creation of all schematics for all subcircuits in a library file, import the library file separately. Note that the
top line of a library file may not be a comment line, so to read it as a stand-alone file, insert a comment line or a
blank line as line 1, if the existing line 1 has information that needs to be processed. Alternately, you may uncheck the
box in the import dialog options page to indicate that the first line is not a comment (refer to Setting the Import
Options), or use the command line argument -| (refer to Executing the Nettrans Command) to deselect the First line is
a comment option.

For a description of the -models command, refer to Executing the Nettrans Command. This command can be used to
read an HSpice model file and create a separate ADS netlist file for each model.

Not supported:

PSpice has a master library file nom.lib that is used by default in PSpice if no library is specified. It also has a LIBPATH
variable in a file called msim.ini. This search path is used in PSpice if the library is not in the working directory. The
ADS translator does not automatically read nom.lib and it does not use the search path. All libraries must be specified
explicitly with a full path if the library file is not in the working directory. If the file nom.lib is needed, an include
statement should be added to the main SPICE file to instruct the translator to read that file.

The HSpice .OPTIONS SEARCH statement is not supported by the translator. All library paths must be explicitly
specified.

.MACRO, .ENDM

The .MACRO statement is processed exactly the same as a .SUBCKT statement. For more information, refer to subckt,
ends.

.MODEL

A .MODEL statement is translated to a corresponding model if a compatible model exists in ADS. For translation details
of specific models, refer to Translating a Model.

Example SPICE Command Line:

. MODEL dnodel D is=le-14
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SPICE Netlist Syntax:

.model name type [param = value* ]

ADS Netlist Syntax:

model name type [param = value* ]

ADS Schematic Symbol:

MODEL

Diode Model
dmodel

.NODESET

This line is translated as a NodeSet control element.

Example SPICE Command Line:

. NODESET V(12)=4.5 V(4)=2.23

SPICE Netlist Syntax:

.nodeset v( node )=val[v(node)=val ]*

ADS Netlist Syntax:

NodeSet:instanceNameNodeName[1]=nodeV[1]=val
[NodeName[2]=node V[2]=val]
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ADS Schematic Symbol:

Node
Set

NodeSetEyName

MNodeSetM1
MNodeMame="net]12” V=45 R=
NodeName="netd4™ V=2.23 R=

Parameters:

node = Node name

val = Voltage at the specified node.

instanceName = Unique component name. This is not provided by SPICE so it is automatically generated by the
translator.

Unsupported syntax:
HSpice .NODESET V(5:SETX)=3.5V

.NOISE

This line is translated as a noise stimulus control element.

Example SPICE Command Line:

.NOISE V(\5) VIN DEC 10 1KHz 100MHz

SPICE Netlist Syntax:

Spice2/3: .NOISE v( out )<,ref> srcname [dec | oct | lin] numpoints fstart fstop [ pts_out ]
PSpice: .NOISE v(out, <,ref>) name=value
HSpice: .NOISE v(out) srcname numpoints
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ADS Netlist Syntax:

AC:cmp99 SweepVar="freq" SweepPlan="fregstim" CalcNoise=yes\

NoiseNode="out"
SweepPlan:fregstim Start=fstart Stop=fstop [Dec=ptsperdec | Oct=ptsperoct/log(2) | Lin=numpoints]

ADS Schematic Symbol:

Parameters:

dec = Sweep by decades
oct = Sweep by octaves

lin = Linear sweep
numpoints = Integer number of points in the sweep. If sweeptype is dec or oct, then this is the number of points

per decade or octave.
fstart = Start frequency
fstop = Stop frequency
poi = List of points

Comments:

HSpice has extended syntax formats that are not supported by the translator. All extra keywords and values are

ignored.
The srcname allows SPICE to compute the output noise referred back to an input node: this usage is ignored by the

translator. The optional pts_out parameter causes a printed output to occur for one of every pts_out frequency points;
this is also ignored by the translator.

.OP

This line is translated as a DC analysis control.
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DC: cnpl

ADS Schematic Symbol:

Parameters:

None. Any optional parameters are ignored.

Comments:

The .OP function in SPICE invokes the simulator to calculate the DC operating point of the circuit. It is sometimes

placed in a netlist just to perform the simplest possible analysis to verify that a dc solution can be found. In ADS, this
is accomplished with a simple dc analysis with no parameters.

.OPTIONS

The only options currently translated are used to set other values on specific components.

Example SPICE Command Line:

. OPTI ONS TNOME25 DCAP=1 WL

SPICE Netlist Syntax:
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. OPTIONS [option nane] * [option_nanme=val ue]*

Parameters:

tnom = Default nominal temperature. Used for models if TNOM is not specified. ADS does not have a global
TNOM parameter. If TNOM is specified on the .OPTIONS statement, the value is copied to all models if the
nominal temperature is not specified directly on the model. Nominal temperature parameters are as follows:

BSIM1, BSIM2........ Temp
MOS_Model9........... Tr
All others.........ccvvvvvvvnnns Tnom or Tref

dcap = Controls the forward bias capacitance of the diode. ADS does not have an equivalent global parameter,
so this is used by the translator to set Fc on the BJT model and Fc and Fcsw on the Diode model. If DCAP is not
set to 1, (.OPTIONS DCAP=1), Fc and Fcsw will be set to 0 on the Diode and BJT models.

wl = If values without parameter names are given for Mosfet length and width parameters, the first is assumed
to be length. If the wl parameter is present with no value, or the value is set to 1, the order is reversed.

The following parameters are default values for mosfets. If no value is given on a mosfet device for a certain
parameter, the SPICE simulator uses the default given here. However, the value of the MOSFET ACM parameter
affects the recognition of these values. There is no global ADS equivalent for these parameters and they are not
currently translated.

defl = Default value for |

defw = Default value for w
defad = Default value for ad
defas = Default value for as
defnrd = Default value for nrd
defnrs = Default value for nrs
defpd = Default value for pd

The following SPICE tolerances have counterparts in ADS on the Options control element but are not set by the
translator. They can be set manually after translation.

SPICE ADS

pivtol PivAbsThresh
pivrel PivotRelThresh
vntol V_AbsTol
abstol I_AvsTol
reltol V_RelTol
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Comments:

For large RFIC designs, the I_RelTol and V_RelTol should be set to a larger value than the default 1e-6. 1e-3 is a
better start value and is the default value for SPICE based simulators. The translator will not set a default value for

these.

.PARAM

This line is translated as a name=value parameter.

Example SPICE Command Line:
. PARAM nane=val ue
SPICE Dialect and Netlist Syntax:

Spice2/3: .PARAM name=value
PSpice: .PARAM name=value (expressions must be in curly brackets)

HSpice: .PARAM name=value (expressions must be in single quotes)

ADS Netlist Syntax:
name=value

ADS Schematic Symbol:

Var Var
Vari
Eqn X=1.0

Parameters:

name = Parameter name
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value = Parameter value

.SUBCKT

ENDS
This line is translated as a parametric subnetwork.

Example SPICE Command Line:

. SUBCKT OPAMP 1 2 3 4
. ENDS

SPICE Dialect and Netlist Syntax:

Spice2/3:

.SUBCKTsubname [ n1*]
.ENDS [subname]

PSpice:

.SUBCKT subname[n1*] [OPTIONAL:interface node = default value ]
[PARAMS: name=value*] [TEXT: name=textvalue]
.ENDS

HSpice:

.SUBCKT subname[ n1* ] [name=value*]
.ENDS

ADS Netlist Syntax

define subname (nl...)
parameters name=value
end subname
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ADS Schematic Symbol:

subname

x1
subname

X2

Parameters:

subname = Subnetwork name

nl* = Node names

name = Parameter name

value = Parameter default value

.ENDS = SPICE subcircuit definitions must end with a .ENDS statement.

Comments:
Spice 3:

Subcircuits may be nested in the SPICE file; however, ADS does not allow this. The translator handles this by writing
each subcircuit definition separately in order of occurrence. Line by line comparison with the original netlist will be
harder in this case since the lines will not match up directly.

PSpice:
OPTIONAL and TEXT parameters are ignored by the translator.

For more information on defining subcircuit parameters, refer to Using the Netlistinclude Component.

.TEMP
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 Note

The translator does not currently translate the TEMP statement. Temp enables you to maintain control over
this setting at the highest level of your design.

To set the simulation temperature, place an OPTIONS element in the highest level of your schematic design, or use an
Options statement in the netlist as shown below in ADS Netlist Syntax.

Example SPICE Command Line:

. TEMP 25

SPICE Netlist Syntax:

. TEMP _tenpval

ADS Netlist Syntax:

Options:options1l Temp\=tempval

ADS Schematic Symbol:

|| oPTIONS

Options
Options1
Temp=25

Parameters:

tempval = Temperature in degrees Celsius.

Comments:
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.TRAN

This line is translated as a transient analysis control element.

Example SPICE Command Line:

. TRAN 1nS 1000nS 500nS 1nS

SPICE Dialect and Netlist Syntax:

Spice2/3:
.TRAN tstep tstop [tstart[tmax]] [uic]

PSpice:
.TRAN[/op] tstep tstop [tstart [tmax]] [SKIPBP]

HSpice: .TRAN varl START= tstart STOP= tstop STEP= tstep
OR .TRAN tstep tstop [tstep2 tstop2 ...] [START=tstart] [UIC]
OR .TRAN DATA=dataname

ADS Netlist Syntax:

Tran:Tranl StopTime=tstop MaxTimeStep=tmax [StartTime=tstart ]

ADS Schematic Symbol:

TRANSIENT

Tran

Tran1

StopTime=100.0 nsec
MaxTimeStep=1.0 nsec

Parameters:
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tstep = Time step between output points.

tstop = Final time.

tstart = Initial time, assumed zero if omitted.

tmax = Maximum step size between simulation points.
varl = Voltage or current source (ignored).

Comments:

.tran is used to perform a time-domain transient analysis.

Optional UIC keyword is ignored by the translator.
MaxTimeStep is calculated by the translator as the smallest of tstep, (tstop-tstart/50 * tmax)

PSpice optional /OP and SKIPBP are ignored by the translator.

HSpice tstep and tstop are ignored for n>1. SWEEP, SWEEP MONTE, OPTIMIZER and DATA keywords are ignored by
the translator.

.FUNC

This is supported for PSpice only.

PSpice Netlist Format:

.FUNC a(b,c) {b+c}

ADS Netlist Format:

a(b, c)=b+c

The .FUNC statement in PSpice is used to define a single line user-defined function. This will be imported as shown
above.
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